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INTRODUCTION 

Welcome to Art & Film Director! 
Art & Film Director is a powerful, full-color, graphics and animation software package 
brought to you by Epyx. In this package you receive two programs--Art Director and 
Film Director. With Art Director you'll create beautiful characters, scenes, and story­
boards. Then add "life" to your creations with Film Director, using techniques similar to 
those used in famous animated films. Finally, put your animated films on video tape to 
enjoy with your family and friends. 

If you're serious about the exciting field of computer art and animation, or if you just 
want to have fun, Art & Film Director is the graphics and animation package for you! 

Art Director 
The Art Director program supplies you with a large canvas, a toolbox of artist's equip­
ment, and a menu bar of options to help you make your painting "picture perfect." You 
can use up to 16 of the Atari ST's 512 colors in each painting. With color cycling, you 
can use up to 128 colors! 

Art Director is easy to use. Drawing tools let you paint in broad strokes or finely adjust a 
delicate line. You can create perfect shapes and fill areas with brilliant color with just a 
few mouse or keyboard moves. 

In addition, the program is loaded with special features. For example, you can make an 
image look three-dimensional, wrap it around a cylinder, even set it spinning on its axis 
and bouncing around the screen! 

Here are just some of the features you'll find in Art Director: 

• Drawing pencil with a wide selection of points in different sizes and shapes. 

• Paintbrush that you can make from any part of your painting, then easily duplicate, 
modify, flip in any direction, and use to fill other images. 

• Shape tools for drawing perfect circles and squares as well as lines, rectangles, ovals, 
and polygons. 

• Palette of 512 brilliant colors. 

• Palette options that let you easily modify colors to achieve lighter and darker shades. 

• Multiple canvasses that you can use at the same time--for example, to swap or 
duplicate colors and images. 
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• Images can be imported from NEOchrome and DEGAS Elite and used just like original 
Art Director images. 

Film Director 
The Film Director program offers you the latest in modem electronic animation tech­
niques. Using Film Director, you can assemble images into animated art pieces that move 
lifelike around the screen. Film Director provides you with toolboxes and menu options 
so the features you need are always just a keystroke or mouse move away. 

Here are some of Film Director's features: 

• Imports and animates Art Director images. 

• Includes graphics on disk that can be assembled into animated figures and back­
grounds. 

• Supplies animation shortcuts that let you set the beginning and end of an action, then 
create all the poses in between. 

• Lets you add text to your scenes. 

• Includes files of sound effects for adding a musical dimension to your film. 

Using This Manual 
The Art & Film Director manual contains complete information on using both Art 
Director and Film Director. Following this introduction you'll find a section on hardware 
requirements, loading instructions, and computer controls for both programs. 

The Art Director section begins with a hands-on learning session. Here you work with 
the program's most frequently used features to create a complete scene on your canvas. A 
reference section follows, containing detailed information about every Art Director 
feature, including the keyboard alternatives to mouse commands. 

The Film Director section provides an overview, a learning session in which you become 
familiar with the program's features while creating an animated figure. The reference 
section that follows provides detailed information on Film Director's animation tools and 
menu options, including how to import and use images created in Art Director and how 
to video-tape your films. A listing of keyboard alternatives to mouse commands ends the 
section. 
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You can learn how to use Art & Film Director easily and quickly by reading this manual 
and experimenting on your computer. Work through the learning sessions from beginning 
to end. They're designed to teach you how to create images in Art Director and animate 
them in Film Director. Practice using the tools and options, and don't be afraid to 
experiment! 

Getting Started 
System Components 
You'll need these components in your computer system to use Art & Film Director: 

• Atari ST computer with mouse 
• TOS (operating system) in ROM 
• Minimum 512K RAM (1 megabyte recommended) 
• 3 1/2-inch floppy disk drive (single-sided or double-sided) 
• Second floppy disk drive or hard disk drive (optional) 
• Color monitor 

If you're going to video-tape your Film Director films, you'll also need these compo­
nents: 

• Color composite output port on your ST, or RGB-to-color composite converter 
• Video cassette recorder (VCR) 
• Computer-to-VCR cabling 

For instructions on connecting your VCR to your computer, see Taping Your Art and 
Films in this manual. 

Art & Film Director Disk Contents 
You receive four disks--two Art Director disks and two Film Director disks--in your Art 
& Film Director package. Each two-disk set contains the program and graphics files for 
the program--Art Director or Film Director--listed on its label. 

Art Director Disk 1 contains the Art Director program file ARTDIR.PRG. The .ART 
files on the disks are graphics and font files you can use as models or practice canvasses, 
and for adding text to your paintings. Use the program ARTCONV.PRG to convert 
graphics files from NEOchrome and DEGAS Elite to Art Director files. The program 
ARTSHOW.PRG lets you run a slideshow of your .ART files. 

Film Director Disk 1 contains theFilmDirectorprogram FILMDIR.PRG. The .FLM 
files on the disks are animated films you can use as models. Use the program 
MUSICSEL.PRG and the sound (.MUS) files to add sound effects to your animated 
films. The program FILMSHOW.PRG lets you show your films. 
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Copying the Disks 

For your convenience, the Art & Film Director disks are not copy-protected. As the 
owner of the software, you are encouraged to make backup copies of these disks for your 
personal use. Making and using backup copies protects you from accidentally erasing the 
original program disks. 

The Art & Film Director disks are single-sided, and can be copied to single-sided or 
double-sided floppy disks . To avoid confusion later, label and date your backup disks as 
soon as you make the copies. Consult your Atari computer manual for full instructions on 
copying disks . 

If you have a hard disk drive connected to your system, you can set up an Art & Film 
Director directory (folder) on it and copy the floppy disk files to that directory. Then you 
can run the programs from your hard disk and easily save your paintings and animations. 
Refer to the manuals supplied with your computer and hard disk drive for complete 
instructions. 

After copying the original disks, store them in a protected place. That way, the programs 
and supporting files will remain safe and available. Always use your backup copies as 
your working disks. 

Art & Film Director is protected by the copyright laws pertaining to computer software. 
This means that copying the program disks for any reason other than an owner's personal 
use and backup purposes is illegal. Epyx, Inc. appreciates your consideration in copying 
the disks for your personal use only, and not to share. This ensures our ability to continue 
to produce high-quality software for you. 

Data Disks 

If you're running Art & Film Director from floppy disks, you 'II want to have several 
blank, formatted disks on hand for saving your work. It's a good idea to format these data 
disks beforehand, although both Art Director and Film Director include disk-formatting 
options, so you won't be caught without a data disk available. 

Loading the Programs 
Art & Film Director uses the ST's 16-color, 320 x 200 pixel mode. The GEM Desktop 
must be in low resolution in order for you to load the programs. 

Follow these steps to load Art Director and Film Director from a floppy disk: 

1. Set up your computer system, following the instructions in your computer manual . 

2. Insert either Art Director Disk 1 or Film Director Disk 1, label side up, into drive A. 
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3. Turn on your system. After a moment, the GEM Desktop appears. If your desktop 

display is in medium resolution, change it to low resolution now. (Use the Set Prefer­
ences option in the Options menu.) 

4. Double-click on the drive A icon. A directory window opens for your disk. 

5. Double-click on ARTDIR.PRG or FILMDIR.PRG, depending on which disk is in the 
drive. 

6. A title screen appears as the program loads. When loading is complete, the program's 
main screen appears. You're now ready to use either Art Director or Film Director. 

To run either program from a system that's already booted, update the directory window 
for the drive that holds your disk, then double-click on either ARTDIR.PRG or 
FILMDIR.PRG. 

Notes and Warnings 

1. If you have a number of custom utilities (such as GDOS) installed, you will not be able 
to load Art Director or Film Director. To load the programs, reboot your system with 
an Art & Film Director disk in drive A, following steps 2 to 6 in Loading the 
Programs. 

2. Art & Film Director is not compatible with desk accessories. If you have desk accesso­
ries installed, they will appear in the Art Director or Film Director Desk menu. How­
ever, DO NOT run them from within either program. 

3. You cannot use Art & Film Director with a RAM disk. 

4. Art & Film Director is not compatible with the Install Application option on the GEM 
Desktop. 

Program Controls 
Mouse 

With Art & Film Director, you use a mouse to draw and manipulate graphics and select 
options. When you roll the mouse on a flat surface, a cursor on screen follows the 
mouse's movements. 

Press the left mouse button to select tools, colors, and menu items, and draw, paint, and 
select images on your canvas. Press the right mouse button to see menus or further 
information about a selected item. 

The terms "left-click" and "right-click" are used throughout this manual to indicate which 
mouse button you should press. The term "double-left-click" means two quick clicks on 
the left mouse button. 
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Keyboard 

You can also operate Art & Film Director from your keyboard. Press one of the four 
Arrow keys to move the cursor one pixel in the arrow's direction. (A pixel is an indivi­
dual screen dot.) Hold down Alternate and press an Arrow key to move the cursor eight 
pixels in the arrow's direction. 

The function keys Fl through FlO activate specific commands, as do many key combina­
tions. See the Keyboard Shortcuts sections in this manual for complete details. 
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USING ART DIRECTOR 

Art Director Screen Components 
During loading, the Art Director title screen is displayed. When the program is finished 
loading, its main screen appears. This is where you create your Art Director paintings. 

Message ­
CioseBox -

and Move Bar 

- Cursor 
Coordinates (x,y) 

Zoom Box -

- Canvas 

Color Swatch -

Palette -

Here's a brief summary of the components of the Art Director screen: 

Toolbox The toolbox contains your painting tools. 

Close Box The close box hides the toolbox to give you a full view of your 
canvas. Place the cursor on the close box and left-click (press the left mouse 
button once) to hide the toolbox. Press the FlO key to return the toolbox to the 
screen. 

Move Bar The move bar moves the toolbox left and right on the canvas. Place 
the cursor on the move bar, hold down the left mouse button, and move the 
mouse left or right. Release the mouse button when the toolbox is where you 
want it. 

Zoom Box The zoom box magnifies the canvas area where your cursor is 
positioned. It also lets you select from eight levels of magnification for detail­
editing on the canvas. 

Tools Use the tools to draw, create shapes, brush on color and patterns, fill 
areas with color, cut out images, add text, and move your canvas on screen. A 
tool that's highlighted is the one that's currently selected. You will use many of 
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the tools in the Art Director Learning Session, next in this manual. Complete 
details about all tools are given in the Art Director Reference section. 

Color Swatch The color swatch shows the color you selected from the palette 
and are now using on the canvas. 

Palette The palette shows the 16 colors currently available for painting on the 
canvas. You can change the palette colors at any time. 

Canvas The canvas is where you draw, paint, manipulate picture sections, and 
place text. Your painting is created on the canvas. 

Message The message shows the tool you are now using and often gives 
information about it. Freehand Draw is the default message when you load Art 
Director. 

Cursor Coordinates (x,y) The cursor coordinates tell you the location of your 
cursor in pixels from the upper left comer of the canvas. Pixels are individual 
screen dots. The pixel in the upper left comer of the canvas is 0,0. The pixel in 
the lower right comer is 319,199. When you first load Art Director the cursor is 
centered at 160x (horizontal), 100y (vertical). 

When you load Art Director, the pencil and freehand tools are highlighted. This means 
they are selected and ready to use. When these two tools are selected, Freehand Draw is 
listed in the message. 

Move the cursor onto the canvas and right-click (click the right mouse button) to see the 
menu bar at the top of the screen. Each of its five selections has a list (menu) of options 
that you can use to work on your paintings. Some of the menu options are used in the Art 
Director Learning Session, next in this manual. Complete details about all menu options 
are included in the Art Director Reference section. Left-click to hide the menu bar. 

Art Director Learning Session 
Creating a simple painting is the best way to acquaint yourself with the Art Director 
program. Follow the step-by-step instructions in this section to paint a tropical scene with 
a palm tree, grass huts, and mountains. This get-acquainted session will show you how 
easy Art Director is to use. 

~(/'Tip: If you don't like something you draw on the screen, left-click on Undo in 
the toolbox (or press the Undo key on the ST keyboard) before you draw 
anything else. Undo erases the last thing you added to the canvas. 

When you load Art Director, the pencil fill and freehand l1 tools are selected (high­
lighted) in the toolbox. When they are selected, you can draw by freely rolling the mouse 
while holding down the left mouse button. 
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Begin by drawing a palm tree. Select a color for the top of the palm tree by moving the 
cursor onto the darker of the two greens in the palette and left-clicking. A dot appears on 
your color choice, showing that the color is selected. The color also appears in the color 
swatch. Then follow these steps: 

1. Position the cursor near the center of the screen, slightly toward the left. 

2. Press and hold down the left mouse button. 

3. Move the mouse to draw the palm fronds. A green line appears as you move the 
mouse. 

4. Finish drawing the top of a palm tree. Make sure you close the outline so there are no 
gaps in it. Release the mouse button when the palm tree top is complete. 

,c:>' Tip: The toolbox disappears as you draw and reappears when you release the 
mouse button. 

Now draw the palm tree trunk by following the steps: 

1. Change your drawing color to brown by left-clicking on brown in the palette. 

2. Draw a tree trunk beginning at the bottom of the green treetop. Again, make sure you 
draw a closed outline. 

,c:>' Tip: The green of the treetop can be considered part of the closed outline. 

3. When your tree trunk is finished, trace your pencil over it without holding down the 
mouse button. Watch the magnified outline in the zoom box. If you see a gap in your 
outline, position it under the small white square in the center of the zoom box and left-
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click. This adds a pixel of brown to your canvas. Close all the gaps in your tree trunk 
outline this way. 

~(/' Tip: If you like, select green again and close up any gaps in your treetop as well. 

Fill in the palm tree and its trunk. Here are the steps: 

1. Select the green color you used to draw the treetop. 

2. Select the bucket r~ tool by moving the cursor onto it and left-clicking. Notice that the 
message changes to Fill and the freehand tool is no longer selected. When you move 
the cursor out of the toolbox, it becomes a bucket with a falling paint drop. 

3. Move the bucket onto the treetop, make sure the paint drop is inside the outline, and 
left-click. The treetop fills with green. 

~<:.::/,. Tip: If the palm treetop is not a completely closed outline, green will leak from 
it and flood the canvas. If that happens, press Esc to stop the fill, then left-click 
on Undo in the toolbox (or press the Undo key). Your treetop returns to its 
outline form. Inspect the outline in the zoom box and close up any gaps. Then 
fill the treetop again. 

4. Fill the tree trunk. Select brown from the palette, then use the bucket to fill the tree 
trunk, the same way you filled the treetop. 

Use the special shapes features to add grass and sky to the drawing. Follow these steps: 

1. Select bright green from the palette. 

2. Right-click on the line-draw !li tool. A selection box appears. 

3. Left-click on the Rectangle selection, then left-click on OK or press Return. Notice 
that the message changes to Rectangle and line-draw is selected in place of the bucket. 

4. Left-click on the close box or press FlO to hide the toolbox. 

5. Move your cursor (a pencil) to a point on the lower left edge of the canvas (somewhere 
between the center and the bottom) and left-click. Small flashing crosshairs appear. 

6. Move the pencil down and to the right. A flashing box begins to stretch across the 
canvas. When you reach the lower right comer, left-click again. The box turns green 
and sets itself in place. 

7. Press FlO to return the toolbox to the screen. 

8. Select the bucket, move it into the green box, and left-click the mouse. The grass area 
fills with bright green. 
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9. When you drew the box, you may have drawn a green line through your tree trunk. If 
so, fill it with brown, using the pencil and either the freehand or line-draw tool. Be sure 
to select brown from the palette before filling the green line. Watch your zoom box to 
help you position the cursor. If you're filling the line with the line-draw tool, left-click 
when you're finished to set the line. 

Now add some mountains and sky to your scene. Follow the steps: 

1. Right-click on the palette and the palette editor appears. 

Dark-Blue Bar 
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2. Left-click on the dark blue bar (9). An arrow appears, showing that the color is 
selected. 

3. Move the cursor onto the RGB grid (RGB stands for Red Green Blue) and position it 
in column G, row 1. Left-click. The blue in the color bar and in the box next to the grid 
changes slightly. 

4. In the same column (G), left-click in row 2, then in row 3, and finally in row 4. Watch 
how the blue color changes. Then move the cursor to column B, row 3, and left-click. 
The blue color changes to a pine green. 

5. Left-click on OK in the palette editor. The color appears in the palette, above the green 
you used for the treetop. The color also appears in the color swatch. 

6. Add a mountain range to your canvas. Select the pencil and the color you just created. 
Draw a jagged outline in the background and fill it in. 

FILL (area wi~h color) 

7. Add a sky. Select sky blue from the palette, place the bucket anywhere in the black 
background, and left-click. 

This picture looks a little barren without signs of civilization. Now's the time to add some 
grass shacks. Follow these steps: 

1. Select the pencil and a yellow color. 

2. Right-click on line-draw and select Rectangle. Left-click on OK or press Return. 

3. Draw a box with its base on the grass. Left-click to set the box. 
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4. Right-click on line-draw again and select Polygon. 

5. Use this tool to draw a roof for your shack. Place the pencil a short distance above the 
center of the box, where you want the peak of your roof. Left-click to set the first 
point. 

6. Move the pencil to a point a little bit to the right of the box's upper right corner. Left­
click to set the second point. 

7. Move the pencil straight to the left. You see the base and third side of a triangle form 
as you move to a point just left of the box's upper left corner. Double-left-click to set 
the triangular roof. The pencil cursor reappears. 

8. Fill the box and triangle with yellow. You now have a grass shack. 

9. Give the shack a door by selecting another color and drawing a small rectangle inside 
the yellow rectangle. Fill the door rectangle. 

FILL (area wi~h color) 

Outline the shack so it shows up clearly on the canvas. Here are the steps: 

1. Right-click anywhere on the canvas to display the menu bar. 

2. Move your cursor to Tools in the menu bar to show the Tools menu. Move the cursor 
down the menu to highlight Outline and left-click. 

3. Outline is highlighted in the selection box that appears. Left-click on OK or press 
Return. 

4. In the toolbox, select black in the palette (left column, second line from the top). Then 
move the cursor onto the grass shack and left~click. The toolbox disappears while a 
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thin black outline is drawn around the shack. When the outline is complete, the toolbox 
reappears. 

~(/' Tip: The program takes several seconds to complete the outline operation. 

There's not much civilization with just one shack. Here's where your brush comes in 
handy. Follow the steps to add more shacks: 

1. Select the brush ~and scissors ~ in the toolbox. A warning box appears . Ignore the 
warning for now and left-click on OK or press Return. Notice that Cut Rectangle 
appears in the message. 

2. Large flashing crosshairs appear on the canvas. Move the center of the crosshairs to a 
point directly above the left end of the roof line and directly left of the roof peak. Left­
click. 

3. Small flashing crosshairs appear. Move the mouse to extend a flashing box completely 
around the shack. When the lower right comer of the box is where you want it, left­
click. 

4. You've created a brush that consists of the grass shack plus some background. Move 
the mouse and you see a duplicate shack moving across the canvas. Place the shack 
where you want it and left-click to stamp it on the canvas. Do this as many times as 
you want, adding more shacks to your scene. 

5. When you finish creating a village, clear your brush. Right-click on the brush in the 
toolbox and select Clear Brush from the selection box that appears. When the warning 
box appears, left-click on OK or press Return. 

6. Use the tools you're familiar with to clean up the background sections that were moved 
with the brush. 

The village could use a welcoming billboard. Make one by following these steps: 

1. Select the pencil and line-draw with the Rectangle option. Select gray from the palette. 

2. Draw and fill two gray boxes, one vertical and one horizontal, to make a billboard for 
your village. 
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"(/' Tip: If you need to move the toolbox out of the way first, place the cursor on the 
move box (the dotted area in the toolbox's upper right comer), hold down the 
left mouse button, and drag the toolbox across the canvas. Release the mouse 
button when the toolbox is where you want it. 

3. Right-click on the text B tool in the toolbox. If a warning box appears, left-click on 
OK or press Return. 

4. In the font size selection box, left-click on Half Size and OK. 

5. Select red from the palette. 

6. Move the cursor--a small flashing box--onto the upper left comer of the billboard. 
Begin typing "Welcome to Club Caribe!" Press Return if you need more than one line 
to fit the words on the sign. 

7. When you finish typing, left-click or press Esc to turn the text into a brush. With your 
mouse, adjust the text so it's placed correctly on the billboard. Then left-click to stamp 
the text onto the billboard. 

Congratulations! You've finished your first Art Director painting! 

To save your painting, insert a data disk into the drive from which you're running Art 
Director. Then right-click anywhere on the canvas to see the menu bar. Move the cursor 
to File. In the File menu, left-click on Save Pict. An item selector appears. Type in the 
filename VILLAGE. Left -click on OK or press Return. Your file will be saved to disk 
under the filename VILLAGE.ART. 
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ART DIRECTOR REFERENCE 
When the Art Director program is finished loading, its main screen appears. The main 
screen contains the features you use to create your paintings. 

Message - - Cursor 
Coordinates (x,y) 

Toolbox - - Canvas 

Message 
The message in the upper left comer tells you what tool you are using, and often includes 
further information about the tool. When Art Director first loads, the message shows 
Freehand Draw. The message changes as you select different tools. 

Cursor Coordinates (x,y) 
The cursor coordinates show the location of your cursor in pixels on the canvas. Pixels 
are individual screen dots, the smallest points of resolution on your monitor. 

The cursor coordinates x,y are relative to the upper left comer of the canvas, where x and 
yare both 0. xis the horizontal coordinate and increases as you move the cursor right. y is 
the vertical coordinate and increases as you move the cursor down. When you first load 
Art Director the cursor is centered on the canvas at 160x,100y. 

The on-screen canvas is 320 pixels wide by 200 pixels deep. The pixel in the upper left 
comer is 0,0; the pixel in the lower right comer is 319,199. When you select the Free 
Cursor option from the Special menu you can move the cursor into an off-screen canvas 
area that is 2000 pixels wide by 2000 pixels deep. 

Press Help to automatically return the cursor to the center of the canvas. 
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Toolbox 
The toolbox contains the features you'll probably use most often with Art Director. 
Normally, the toolbox disappears while you're using a tool and reappears when you're 
finished. You can set the toolbox to remain on screen continuously by using the Toolbox 
option in the freehand tool's selection box. (See Freehand in this section for more 
information.) 

Close Box 
and Move Bar-

Zoom Box-

Color Swatch---

Palette-

Close Box 
The close box hides the toolbox so that you can see the entire canvas. Left-click on the 
close box to remove the toolbox from the screen. To return the toolbox back to the 
screen, select the Show Toolbox option in the Special menu. 

You can also press FlO to toggle between hiding and showing the toolbox. 

Move Bar 
The move bar moves the toolbox left and right on the canvas. Position the cursor on the 
move bar, hold down the left mouse button, and move the mouse left or right to move the 
toolbox. 

Zoom Box 
The zoom box magnifies the area of the canvas where the cursor is positioned. Use the 
zoom box to do fine detail work or to determine the exact pixel position of the cursor. 
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The white square at the center of the zoom box marks the cursor's position on the canvas. 
You can move the cursor over an image on the canvas to see its color composition pixel 
by pixel in the zoom box. If you are using the pencil in freehand mode, you can color a 
single pixel on the canvas by positioning the pixel under the white square in the zoom 
box and left-clicking. 

Right-click on the zoom box to see its selection box: 

Magnification The eight multiplier selections are the levels of magnification in 
which you can display your canvas. 

Make your selection and left-click on OK or press Return. The cursor returns to the 
zoom box. Move the cursor onto the canvas and a flashing box appears on your canvas, 
showing you what the visible canvas area will be at the magnification you selected. 

Move the flashing box over the area you want to magnify and left-click. The area appears 
magnified on the canvas. In the zoom box, the area appears in its default (non-magnified) 
size. The cursor becomes a box the size of a pixel on your magnified canvas. 

While the canvas is magnified, you can place color on it pixel by pixel. You can work 
only with the pencil. The only selection you can make is to choose a different color from 
the palette. If you make any other selection, the canvas will return to its default size. 

To return the canvas to its default size, either left-click on the zoom box, select any other 
screen option, or press Esc. 
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Pencil B 
The pencil draws freehand lines and figures, straight lines, and a variety of shapes, 
including circles, rectangles, and polygons. Left-click on the pencil to select it. 

When the freehand tool is selected along with the pencil, you can draw freehand by 
moving the cursor over the canvas while holding down the left mouse button. When line­
draw and the pencil are selected, you can draw straight lines and defined, regular shapes. 

Right-click on the pencil to see its selection box: 

- One-Size Shapes 

- Any-Size Shapes 

One-Size Shapes These selections determine the size of your pencil point. 

Any-Size Shapes These selections let you create shapes in any size. The filled 
shapes are drawn filled with color. The unfilled shapes are drawn as outlines. 

Make your selection and left-click on OK or press Return. If you selected a one-size 
shape, hold down the left mouse button while moving the mouse to draw. 

If you selected an any-size shape, left-click anywhere on the canvas to set a point where 
your shape will begin. Then move the cursor to extend your shape to the size you want. 
Left-click. The shape appears, and you can move it wherever you want on the canvas. 
When the shape is positioned, left-click to stamp it. You can paint with the shape by 
holding down the left mouse button while moving the mouse. 

Your pencil retains your selection until you change it from the pencil selection box. 
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Brush i'j 
The brush is a tool you define by cutting out a block of color, an image, or a piece of text 
on your canvas. Once you create a brush, you can paint with it in ways similar to using a 
real paintbrush. 

Left-click on the brush in the toolbox. If no brush was previously selected, a default 
brush is provided for you. 

c?' Tip: If you've cleared a previously selected brush, a dialog box appears telling 
~ you that no brush is selected. Left-click on OK or press Return. When you 

move the cursor onto the canvas, you will see a small "No" attached to the 
cursor. You cannot use this "No" as a brush. 

Define a new brush by clipping a shape from your canvas with the scissors. (See Scissors 
later in this reference section.) With a brush defined, right-click on the brush in the 
toolbox to see its selection box: 

Transp With this selected, any parts of the brush that match the canvas's 
background color will be "transparent" When you move the brush, any other 
colors on the canvas will show through the "transparent" brush sections. 

Block With this selected, the entire brush will be visible, including any brush 
sections that match the canvas's background color. Irregular brushes (cut out 
with the freehand selection from the scissors' selection box) are placed in a 
rectangle of background color. 

Silhou With this selected, the original brush becomes a silhouette of solid color, 
depending on the color selected in your palette. Any parts of the original brush 
that matched the canvas's background color will be transparent. Use the Silhou 
selection to create shadows for images on your canvas. 
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Flip Hor This selection flips the brush left to right. 

Flip Ver This selection flips the brush top to bottom. 

Halve Hor This selection reduces the width of your brush by half. Select Halve 
Hor again to continue reducing your brush. 

Halve Ver This selection reduces the height of your brush by half. Select Halve 
Ver again to continue reducing your brush. 

,. Tip: Halving a brush eliminates every other row or column of pixels in the 
"<:? direction of the halving. Because of this, some detail may be lost, and doubling a 

halved brush will not restore it to its original look. 

Double Hor This selection doubles the width of your brush. Select Double Hor 
again to continue doubling your brush. 

Double Ver This selection doubles the height of your brush. Select Double V er 
again to continue doubling your brush. 

,. Tip: Doubling a brush duplicates every row or column of pixels in the direction 
" (/ of the doubling. Halving a doubled brush restores the brush to its original look. 
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Turn 90° Right This selection rotates your brush 90 degrees to the right. 

Turn 90° Left This selection rotates your brush 90 degrees to the left. 

Assimilate This selection uses the colors in your current palette to change the 
colors of your brush. Assimilate is useful when your brush is taken from one 
canvas and brought onto another canvas with a different palette. After using 
Assimilate, the new colors in the brush will be as close as possible to the 
original colors, depending on your palette. 

For example, suppose you create a brush by clipping out a tire from the graphics 
canvas CAR.ART. Then you clear your canvas in order to work on another 
painting. When the second painting appears, the "tire" brush is still active. But 
its colors are now taken from the current palette and are different from the 
palette colors in CAR. ART. The tire looks strange because its colors aren't 
chosen correctly. Select Assimilate from the brush selection box. Art Director 
will choose colors from the new palette that are as close as possible to the tire's 
original colors, and recolor the tire. 

Clear Brush This selection deletes your brush. A warning box alerts you that 
the process is irreversible. Left-click on OK or press Return. When the canvas 
reappears, the cursor includes the small "No," reminding you that no brush is 
selected. (You can also press Control S to clear your brush.) 
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Make your selections and, if needed, left-click on OK or press Return. Move your brush 
around the canvas by moving your mouse. Left-click to stamp the brush in place, or hold 
down the left mouse button while moving the mouse to paint with your brush across the 
canvas. 

Freehand II 
Select the freehand tool when you want to move the cursor freely on your canvas. With 
the freehand tool you can also select either the pencil (for Freehand Draw), the brush (for 
Freehand Paint), or the eraser. 

Right-click on freehand to see its selection box: 

Cursor Speed-

Freehand Draw These selections determine the look of your freehand line. 
Select the left box to draw coarse, sometimes broken, lines. The faster you move 
the mouse, the coarser the lines will be. Select the right box to draw smoother, 
more evenly colored lines. These selections are effective only in Freehand Draw 
(with the pencil selected). 

c:>' Tip: Shapes drawn with coarse lines will generally "leak" when filled with the 
~ bucket. 

Toolbox Select Hide to make the toolbox disappear while you're using a tool on 
the canvas. Select Show and the toolbox remains on screen continuously. (You 
can still toggle the toolbox off by pressing FlO or using the Hide Toolbox option 
in the Special menu.) 

Cursor Speed Your selection--Slow, Medium, Normal, or Fast--determines 
how fast the cursor responds to your mouse movements. 

23 



Mirror V and Mirror H Each of these selections divides the canvas into two 
sections that mirror each other. Anything you add to one section simultaneously 
appears in a mirror position in the other section. 

Select On to activate a mirror. Mirror V divides the canvas vertically; Mirror H 
divides it horizontally. The coordinates tell where the canvas will be split (160x 
is the vertical center of the canvas; lOOy is the horizontal center). With both 
mirrors on, the canvas is divided into four quadrants. 

Select Off to deactivate a mirror. 

Set Mirror Position? Select Yes to change this option to modify your Mirror V 
and Mirror H settings. These new settings remain as your default settings. A 
cross-shaped cursor and flashing crosshairs appear. Left-click and move the 
mouse to move the flashing crosshairs. These define your mirror quadrants. 
Left-click again to set your mirror quadrants. Draw in one quadrant and vertical 
and horizontal mirror images simultaneously appear in the others. 

(/,. Tip: The line-draw tool also uses the mirrors activated from the freehand 
~ selection box. 

Make your selections and left-click on OK or press Return. 

Line-Draw Ill 
Line-draw lets you draw straight lines, circles, ovals, squares, rectangles, and other 
figures. Right-click on line-draw to see its selection box: 
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Straight This selection draws a straight line between two points. To use 
Straight on the canvas, position the cursor where you want one end of the line 
and left-click to set the point. Release the mouse button and move the cursor to 
where you want the line to end. Left-click again. A line appears, drawn between 
the two points. 

Zigzag This selection draws a series of connected straight lines. To use Zigzag 
on the canvas, position the cursor where you want the first line to start. Left­
click to set the point. Release the mouse button, then move the cursor to where 
you want the first line to end and the second line to start. Left-click to set that 
point, then move the cursor to the third point. Continue until your figure is 
complete, then double-left-click to set it. 

Rays This selection draws lines outward from a central point. To use Rays on 
the canvas, position the cursor, then left-click to set the central point. Move the 
cursor to where you want the first line to end and left-click again. Next, move 
the mouse to where you want your second line to end and left-click. Repeat to 
draw as many rays from the central point as you want. When your figure is 
complete, double-left-click to set it. 

Polygon This selection draws multi-sided, multi-angled figures. To use Polygon 
on the canvas, move the cursor to where you want the first point and left-click to 
set the point. Then move the cursor to the second point and left-click. A straight 
line appears. Move the cursor to the third point. Two flashing lines follow the 
cursor. One line is connected to the last point set and the other is connected to 
the first point set. Left-click to set the third point. Continue setting as many 
points as you want. When your figure is complete, double-left-click to set it. 

Square This selection draws perfect squares. To use Square on the canvas, 
position the cursor where you want the upper left comer of the square. Left-click 
to set the comer. Move the cursor down and to the right. A flashing box follows 
the cursor. When the square is the size you want, left-click to set it. 

Rectangle This selection draws rectangles. To use Rectangle on the canvas, 
position the cursor where you want the upper left comer of the rectangle. Left­
click to set the comer. Move the cursor down and to the right. A flashing box 
follows the cursor. When the rectangle is the size you want, left-click to set it. 

Circle This selection draws perfect circles. To use Circle on the canvas, 
position the cursor where you want the center of the circle and left-click. Then 
move the cursor in any direction. A flashing circle follows the cursor, centered 
on your first point. When the circle is the size you want, left-click to set it. 

Oval This selection draws ovals. To use Oval on the canvas, position the cursor 
where you want the center of the oval and left-click. Then move the cursor in 
any direction. A flashing oval follows the cursor, centered on your first point. 
When the oval is the size you want, left-click to set it. 
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Make your selections, then left-click on OK or press Return. Now you can use your 
selection on the canvas. 

(/,. Tip: Select Undo from the toolbox or press Undo on the keyboard before setting 
~ your last point to erase what you've drawn and start over. 

Scissors m 
The scissors tool defines a brush by cutting out an image on the canvas. Left-click on 
scissors, then move the cursor onto the canvas. Large flashing crosshairs appear. Position 
the center of the cross hairs at the upper left comer of the image you want to cut out and 
left-click. The crosshairs become smaller. Hold down the left mouse button and drag the 
cursor to the lower right of your image. When the image you want is surrounded by a 
flashing outline, left-click. Your image becomes a brush which can be used with the same 
tools available for the pencil. 

Right-click on the scissors to see its selection box. 
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Rectang This selection cuts out a rectangular section on the canvas. 

Freehnd This selection lets you trace around an image in freehand in order to 
cut out an irregular shape. Use the zoom box with this selection to see exactly 
where you're cutting. 

Oval This selection cuts out an oval section on the canvas. 

Pattern This selection is available after you've loaded the file FILLPTRN.ART 
onto your canvas. On the canvas, move the cursor from pattern to pattern. A 
flashing box surrounds each pattern as the cursor points to it. When the cursor is 
on the pattern you want, left-click. The pattern will be cut out as your brush. 
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C',. Tip: You can modify the designs in FILLPTRN.ART or create your own in the 
~ empty boxes provided. 

Make your selections and left-click on OK or press Return. Now you can proceed to cut 
out your image using the scissors tool. 

Bucket~ 
Use the bucket to fill an area with color or with the image chosen as your brush. 

To fill with color, select the bucket and the pencil from the toolbox and a color from the 
palette. Move the drop on the bucket cursor onto the area you want to fill and left-click. 
The fill will occur in the selected color. If you've selected a special tip for your pencil, the 
fill will also be in the shape of the tip. 

To fill with a brush image, select the bucket and the brush from the toolbox. Move the 
drop on the bucket cursor onto the area you want to fill and left-click. The area will be 
filled with brush images. 

C',. Tip: Be sure the drop on the bucket cursor is in the area you want to fill before 
~ left-clicking. Watch the zoom box for help if needed when positioning the drop. 

To stop a fill, press Esc. Select Undo from the toolbox or press Undo on the keyboard to 
erase the fill. 

Right-click on the bucket to see its selection box. 
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Fill Area This selection fills an area that is a single color and is completely 
enclosed by any other color or colors. 

Suppose you have a section of canvas that is solid green. Draw a circle in that 
section, using blue. You can then fill in the green circle with blue or any other 
color, using Fill Area. Be sure the drop on the paint bucket cursor is on a green 
pixel inside the blue circle before left-clicking to begin the fill. 

If any pixels of the color being filled (green in the example above) occur in the 
enclosing line, the fill color will "leak" out. When this happens, press Esc to 
stop the fill, and use Undo to erase it. Color the gap using your pencil and 
another color, then refill the area. 

Also, if any pixels of a color different from the color being filled occur in the 
area, they will not be filled. In the example above, if any red pixels occurred in 
the green fill area, they would not be affected by the fill color (the color in the 
color swatch). 

Fill Contour This selection fills an area enclosed by the color in the color 
swatch (the fill color). All pixels in the enclosed area will be filled, regardless 
of the color touched by the bucket's drop when you left-click to begin the fill. 

For example, suppose you enclose the car in CAR.ART in a white rectangle. 
You can now fill that rectangle with white by using the Fill Contour selection 
and left-clicking anywhere within the rectangle (making sure white is still the 
color selected in the palette). The fill continues until it meets the rectangle. 

If any pixels of a different color occur in the white rectangle, the fill color will 
"leak" out. Fix the gap with white and refill. 

Eraser~ 
Use the eraser to erase a portion of the canvas down to the background color. The eraser 
can be used with either the freehand, line-draw, or bucket tool and features from that 
tool's selection box. (See the section describing a tool for full information on using it.) 

(?,. Tip: The eraser wipes away all colors down to the background color. If you are 
~ drawing a figure in one color over something in another color, both colors will 

be erased when you use the eraser on them. 

Right-click on the eraser to see its selection box. Left-click on the eraser size--Small, 
Medium, or Large--you want. Then left-click on OK or press Return. 

~(/,. Tip: Any pencil point will act as an eraser when the background color is 
selected from the palette. 
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Text B 
The text tool lets you add text in your canvas. Once added, the text becomes a brush. 

Left-click on text in the toolbox. If a brush is already defined, a warning box appears. 
Left-click on OK to continue. 

Move the cursor onto the canvas. The cursor appears as a small flashing box. Begin 
typing. Your text appears in the color chosen from the palette. Press Return when you 
want to start a new line of text. Press Backspace to delete the text character to the left of 
the cursor. 

C',. Tip: To clear your typing and begin again, left-click on Undo in the toolbox or 
~ press Undo on the keyboard. 

When you finish typing, press Esc or left-click. The text becomes a brush. Position the 
text where you want it on the canvas and left-click to set it. 

(/,. Tip: Your text can be used exactly like any other brush, and is affected by your 
~ selections from the brush selection box. For example, selecting Clear Brush 

from the brush selection box clears the text from the brush. 

Right-click on text to see its selection box: 

Font Size Select the font size you want to use. Regular (6 x 8 pixel) and half­
size (3 x 8 pixel) fonts are always available. Make your selection and left-click 
on OK or press Return. 
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Other font sizes can be loaded from Art Director Disk 2. Follow these steps to load the 
fonts: 

1. Left-click on Page Swap lEI in the toolbox to display a blank canvas. (See Page Swap 
in this section for full information on using that tool.) 

2. Insert Art Director Disk 2 into the drive from which you're running the Art Director 
program. 

3. Right-click anywhere on the canvas to display the menu bar. 

4. Move the cursor to File in the menu bar to see its menu. Move the cursor down to 
highlight Load Pict (the first menu option) and left-click. 

5. A warning box appears. Left-click on OK or press Return to continue. An item 
selector appears, listing the files on the disk. Art Director font files begin with FNT 
and end with the extension .ART. 

,. Tip: If the font files don't appear in your item selector, they may be on Art 
~(/ Director Disk 1. Insert that disk into your drive and update your item selector. 

See the section Load Pict later in this manual for full information on using the 
item selector. 

6. Left-click on a font file. Then left-click on OK or press Return. The file loads and the 
font appears. 

7. Left-click on Page Swap in the toolbox. Your canvas appears. 

8. Right-click on text in the toolbox and on OK in the warning box that appears. When 
the selection box appears, you'll see that an additional font size is now available to 
select and use on your canvas. 

(/,. Tip: You can create custom fonts by redrawing the characters in an existing font 
~ file. Be sure to keep your new characters within the boxes. Then save your 

custom font file under a new filename. 

Scroll m 
The scroll tool lets you move your canvas right, left, up, or down on the screen. Select the 
tool, then move the cursor onto the canvas. Hold down the left mouse button and move 
the mouse to move your canvas. 
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Right-click on scroll to see its selection box: 

Single Page This selection moves one canvas around the screen. 

Both Pages This selection lets you scroll between your front and back pages. 
This is handy when you want to work on the junction between pages. When 
Both Pages is selected, the tool in the toolbox changes to two hands. 

1 Pix Either selection moves the canvas one pixel in the arrow direction. 

Make your selection, then, if needed, left-click on OK or press Return. 

Page Swap~ 
The page swap tool lets you move different canvasses onto the screen from "pages" in 
memory. Left-click on page swap. The canvas that was on the back page now appears on 
your front page on screen. (If a painted canvas was not previously moved to the back 
page, the new canvas will be blank.) 

When you swap pages, the canvas on the front page is moved to the back page. Select on 
the tool again to bring the original canvas back on screen. 

c/,. Tip: The canvas on screen is always your front page. 
~ 
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Right-click on page swap to see its selection box: 

Front Page This line tells you what page is currently showing as your front 
page. 

Select New Front Page This selection lets you choose a new canvas for your 
front page from up to 16 different canvasses held in memory. The current front 
page is highlighted. The current back page is in "ghost" type. For your new front 
page, left-click on any page except the back page. 

Make your selection and left-click on OK or press Return. The canvas on the selected 
page appears as your new front page. If the canvas has not yet been worked on, it will be 
blank. 

A canvas always stays on the letter page you put it on originally. 

,. Tip: You can store up to 16 pages of canvasses in memory if your computer has 
~(/ 1 megabyte or more of RAM. If your computer has only 512K of RAM, you 

will have only two pages (front and back) available, and the swap page selection 
box will not be active. 

Undo fHH 
The Undo tool lets you erase ("undo") the action you most recently performed on the 
canvas. To undo, left-click on Undo in the toolbox. Pressing the Undo key on your 
keyboard has the same effect. 

(/,. Tip: Only your last action will be erased; you can't undo any actions before that. 
~ However, you can erase your last undo operation. Select Undo again (or press 

Undo). The former look of the canvas will be restored. 
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Display IB 
The Display tool toggles certain screen displays, including the message and cursor 
coordinates, on and off. Left-click on Display to hide those features. Left-click on the 
tool again to return the display to your screen. 

Right-click on Display to see its selection box: 

Message Selecting On displays the message at the top left of the canvas. 
Selecting Off hides it. 

Coord Selecting On displays your cursor coordinates at the top right of the 
canvas. Selecting Off hides them. 

V Scale Selecting On displays a vertical scale at the left side of the canvas. The 
longer marks on the scale are spaced five pixels apart. Selecting Off hides the 
scale. 

H Scale Selecting On displays a horizontal scale at the bottom of the canvas. 
The longer marks on the scale are spaced five pixels apart. Selecting Off hides 
the scale. 

Make your selections and left-click on OK or press Return. Now, clicking on the Display 
tool toggles a display on and off of those selections that are "on" in the selection box. The 
selections that are "off' will not appear. 
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Color Swatch 
The color swatch shows the color currently selected in the palette. Left-click on the color 
swatch to fill the canvas with its color. A warning box appears. Left-click on OK or press 
Return to fill the canvas with color. 

(/,. Tip : Left-clicking on the color swatch covers over any work on your canvas. If 
~ you left-click on the color swatch in error, left-click on Undo in the toolbox or 

press the Undo key to restore your work. 

Right-clicking on the color swatch displays the palette editor, which is explained in the 
Palette Editor section later in this manual. 

Palette 
The palette shows the 16 colors currently available for painting and drawing on your 
canvas. You can change the palette colors at any time by using the palette editor and 
choosing from the ST's selection of 512 colors. 

The color marked with the letter B (upper left comer of the palette) is the background 
color. The background color is the color of the canvas, and other colors are applied over 
it. The default background color is black. 

Left-click on a color in the palette to select it. A flashing dot appears on the color, 
indicating that it is selected, and the color appears in the color swatch. When you use a 
tool, the color you apply will be the currently selected palette color. 

Palette Editor 

Use the palette editor to change the colors in your palette, and to create up to seven 
additional palettes for the canvas, each containing 16 colors. Right-click on the palette or 
the color swatch to see the palette editor: 

PALETTE EDITOR R8-G4-B7 

u, @B c D E F c II 0 c:=:J 
PALETTE 1 

TIME 2 ;,:.c~~-;;:, 

@o 0 0 0 0 0 0 :~-< 

I 4 

COPV3(SUAP s-RGB 6-
Palette Selector 

:olor Cycle Timer 

Color Mixer Ill 
INVERT 7-8 ~ 

VIEW COLOR 9 
VIEW MONO 10 

VIEUCVCLE 
11-
12-

UNDO 1:1-

n OK 
14-

iliiii IS-

Paintbox 

Color Bar 
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Paintbox The colors shown in the paintbox are the colors currently in your 
palette. The colors are numbered as they appear in the palette from top to 
bottom. Colors 0 through 3 are in the far left column of the palette; colors 4 
through 7 are in the center left column; colors 8 through 11 are in the center 
right column; and colors 12 through 15 are in the far right column. The arrow 
marks the color currently showing in the color mixer, and that color's RGB value 
appears in place of the cursor coordinates on the top left of the canvas. 

Color Mixer Use the color mixer to modify the colors in your palette. You can 
change one color at a time in the color mixer. The color currently in the mixer is 
shown with its RGB value. 

The RGB value is composed of three digits representing the red, green, and blue 
light intensities, in that order, of the color. The eight intensity levels are num­
bered from 0 (least intense) to 7 (most intense). There are 512 RGB combina­
tions (8 x 8 x 8 = 512), making 512 colors possible. 

To change a color in the color mixer, move the cursor onto an empty square in 
the RGB grid and left-click. The square will be highlighted and the color in the 
color bar will change, reflecting the new RGB value you just set. The same color 
in the paintbox will also change to the new color. When you return to the 
canvas, the new color appears in the palette (and on your canvas) in place of the 
original color. 

,. Tip: Do not set colors 0 and 15 to the same RGB value. Color 0 is the back-
~(/ ground color, and color 15 is the outline and type color of the palette editor. If 

you set both colors to the same value, you will not be able to read the palette 
editor. If this happens, press Help to make your screen readable. 

Palette Selector You can use up to eight palettes per canvas to create color 
cycling. Color cycling scrolls colors from different palettes through the same 
image or images on a canvas, creating the effect of motion. 

In the palette selector, the palettes are labeled A through H. Left-click on a 
palette letter to select it. The letter of the palette currently selected has a box 
around it, and the colors of that palette appear in the paintbox. 

Color Cycle Timer The color cycle timer lets you set up and activate color 
cycling. Follow the steps: 

1. On your canvas, draw an image using palette A (your first color palette). 

2. Left-click on the palette to display the palette editor. 

3. Left-click on B in the palette editor to select the second palette. 

4. Modify the colors in the palette B paintbox. The colors you modify must be 
the colors used in your drawing. 
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5. Select palette C and modify the same colors again. 

6. Continue selecting palettes and modifying colors until you have all the 
palettes you want or you've used all eight palettes. 

7. Set the time each palette will remain on screen in a color cycle. To do that, 
left-click on the number in the color cycle timer that's below the palette letter. 
The number represents a relative time scale and may be set from 0 (fastest) to 
9 (slowest). The number increases by one with each left-click. 

8. To preview your color cycling, hold down the left mouse button on View 
Cycle in the palette editor. 

To view your color cycling from the canvas, left-click on OK or press Return to 
return to the canvas. Then right-click anywhere on the canvas to display the 
menu bar. Move the cursor to Special to see its menu, and left-click on the Color 
Cycle option. Click a mouse button to stop the color cycling. 

Copy This selection copies colors and palettes. The purpose of Copy is to move 
colors around within a palette. Doing this helps you set up color cycling, 
because the position of a color within a palette determines if and when it will 
appear in the cycle. 

To copy a color within the same palette, first left-click on the color you want to 
copy in the paintbox. Then left-click on Copy. Finally, left-click on the color in 
the paintbox you want to copy over. The first color selected in the paintbox is 
copied over the second color. In the palette on the canvas, the first color selected 
will appear in its original position and in the position of the second color 
selected. 

To copy a palette, select a palette letter in the palette selector at the top of the 
palette editor. Then left-click on Copy. Finally, select a second palette letter in 
the palette selector. The colors in the first palette selected will be copied to the 
second palette selected. 

Swap This selection exchanges colors within a palette or from palette to palette. 
Doing this helps you set up color cycling, because the position of a color within 
a palette determines when it will appear in the cycle. 

To exchange colors in the same palette, select one color from the paintbox. Then 
left-click on Swap. Move the cursor back to the paintbox and select a second 
color to exchange with the first color. The two colors will trade places in the 
paintbox. 

To exchange the colors of two palettes, first select a palette letter in the palette 
selector. Then left-click on Swap. Finally, select a second palette letter. The 
colors of the two palettes will be swapped. 



emmnpo 
Invert When you left-click on this selection, it inverts all colors on the palette. 
Inverting a color changes it to its complementary color--one that has the 
opposite RGB value. 

View Color Hold down the left-mouse button on this selection to view your 
canvas in the current palette colors. Release the mouse button to return to the 
palette editor. 

View Mono Hold down the left mouse button on this selection to view your 
canvas in shades of gray. Release the mouse button to return to the palette 
editor. 

View Cycle Hold down the left mouse button on this selection to preview your 
color cycling. 

Undo Left-click on this selection to cancel the last action you took in the palette 
editor. 

Make your selections, then left-click on OK to return to the canvas. 

Art Director Menu Bar 
Whenever you right-click on the canvas, the menu bar appears across the top of your 
screen. The menu bar contains five selections, each having a drop-down menu of options. 
You'll use the options both for working on your canvas and for manipulating picture files. 

- Art Director Menu l 
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Desk The Desk menu contains an option that displays the program credits and 
version number. 

File The File menu includes options for loading, saving, deleting, and printing 
files, formatting data disks, and exiting the program. It also provides an option 
for saving your Art Director preferred settings. 

Effects The Effects menu contains options for manipulating a defined section of 
your canvas. The image created by one of these options becomes a brush. 

Tools The Tools menu contains painting tools, such as the spray can and the 
outline option, that produce complex effects. 

Special The Special menu includes miscellaneous options both for achieving 
special effects and for controlling the on-screen components. 

With the menu bar displayed (right-click on the canvas), move the cursor to any selection 
to see its menu of options. Move the cursor up and down a menu to highlight individual 
options. When an option is highlighted, left-click to select it. 

If you decide not to select any menu option, left-click anywhere outside the menu and it 
disappears. Left-click again to return to continue working on your canvas. 

Desk Menu Option 
The Desk menu contains the About Art Director option. 
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Select this option to see the Art Director design credits and version number. Left-click on 
OK in the dialog box or press Return to return to your canvas. 

File Menu Options 
The File menu contains options for loading, saving, deleting, and printing files, format­
ting data disks, and exiting Art Director. It also provides an option for saving the pro­
gram preferences you set with Art Director. 

Load Pict 

The Load Pict option loads a painting file onto your canvas. Select the option and left­
click on OK in the warning box that appears (or press Return). An item selector appears 
listing the .ART files on the disk currently in the drive. These files can include paintings 
you've created and saved, text fonts, fill patterns, and clip art. 

(/,. Tip: The item selector for your disk may list different .ART files than those 
~ shown here. 
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Selection Line 

File Directory Scroll Bar 

Scroll Arrow 

Left-click on a filename to select it, then left-click on OK or press Return to load the 
file. If the file directory is longer than one screen, drag the scroll bar up and down or left­
click on the item selector's scroll arrows to see all file selections. 

You can edit the directory line to access a different drive, directory (folder), or group of 
files with extensions other than .ART. Left-click on the directory line, press Backspace 
or Esc to erase, then enter a new pathname. Move the cursor into the scroll bar and left­
click again. The new directory appears. 

Another shortcut (if you know the name of the file you want) is to type the filename on 
the selection line and left-click on OK or press Return. If the file is on the disk in the 
drive (and folder) listed in the directory line, it will be loaded onto your canvas. 

Select Cancel in the item selector if you don't want to load a file. 

c:>~' Tip: See your ST manual for full information on using the item selector. 
~ 

Save Pict 

The Save Pict option saves the on-screen canvas to disk as an Art Director file. When 
you select the option, the item selector appears. If you are saving the canvas as a new file, 
type a filename for it using up to eight characters. (Before typing, make sure the cursor is 
on the selection line. If it isn't, left-click on the selection line to move it there.) The 
filename will be entered on the selection line. Then left-click on OK or press Return. 
Your canvas will be saved to the disk in the drive listed on the directory line, and its 
filename will be given the extension .ART. 
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If your canvas already has a filename, left-click on it in the file directory, then left-click 
on OK or press Return. A dialog box asks if you want to overwrite the existing file. If 
you do, left-click on Yes or press Return to save the file. 

Before saving a file, you can edit the directory line to indicate a different drive or 
directory (folder) where the file will be saved. Left-click on the directory line, erase by 
pressing Backspace or Esc, and type a new pathname. Then save your canvas as already 
described. 

0 , Tip: The Save Pict option saves only the on-screen canvas, and not all the pages 
~ in memory. Those must be brought on-screen and saved in their own files. 

Save Pref 

Select the Save Pref option to save the following settings to disk: 

• The File menu/Set Printer option setting (pixels per line on printed work). 

• The Special menu/Warnings option settings (warning boxes displayed or hidden). 

• The Special menu/Free Cursor option setting (cursor restricted to the visible canvas 
area or freed to move beyond it). 

• The selections you made from the Display tool's selection box (message, cursor 
coordinates, and vertical and horizontal scale display on or off). 

When you select Save Pref, an item selector appears. Save your preferences to the disk 
containing the Art Director program ARTDIR.PRG. Check the directory line in the item 
selector to make sure the drive (and directory, if needed) is correct. (If either is not, edit 
the directory line.) 

Also make sure the disk containing ARTDIR.PRG is in the drive named on the directory 
line. Then left-click on OK or press Return. 

The settings are saved in a file named A.PRE on the disk in your working drive. That 
disk should also contain the Art Director program file ARTDIR.PRG. The next time you 
load Art Director from that disk, those settings will be in effect. 

Set Printer 

The Art Director program can print to any Epson or Epson-compatible dot-matrix printer. 
With a printer connected to your system, use the Set Printer option to set the resolution 
(pixels per line) of your printed work. 
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First, consult your printer owner's manual to find out whether your printer uses 960 or 
1280 pixels per line. Generally, 960 pixels per line is chosen for narrow carriage (8 1/2 
inches wide) printers; 1280 pixels per line is chosen for wide carriage printers. Then 
select Set Printer. In the selection box, left-click on either 1280 or 960, depending on 
your printer. Then left-click on OK or press Return. 

Print Pict 

Select the Print Pict option when you're ready to print a canvas. A selection box appears: 

Print Page Select Single to print the canvas currently on screen. Select Double 
to print both the front and back pages of your canvas in that order. 

Mode Select Normal to print the canvas as you see it. Selecting Flip prints the 
canvas in reverse, right to left. 

Page Size These numbers show the size at which the current canvas will be 
printed. The size is expressed as width by height in pixels. 

Rescale Page Select Yes to change the size of the printed canvas. A flashing 
border appears around the canvas. To rescale, move the mouse to move the 
lower right comer of the flashing border. When the border is the size you want, 
left-click to begin printing. 

After making your Print Page and Mode selections, left-click on OK or press Return to 
begin printing. When you rescale a page, printing begins automatically. 

(/" Tip: Be sure you have your printer set up and ready to print before making your 
~ selections. 
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Delete File 

Select the Delete File option to erase a file from disk. The item selector appears. In the 
file directory, left-click on the filename of the unwanted file. When the filename appears 
on the selection line, left-click on OK or press Return. In the dialog box that appears, 
left-click on OK again or press Return. The file will be deleted from the disk and cannot 
be retrieved. 

In the Delete File item selector, you can edit the directory line to access a different disk 
or directory (folder). Left-click on the line, press Backspace or Esc to erase, then type a 
new pathname. Move the cursor into the scroll bar and left-click to update the file 
directory. Then delete a file as explained. 

Format Disk 

The Format Disk option lets you format a disk without leaving the Art Director program. 
This can be a great help when you want to save a canvas but you're caught without a 
formatted disk handy. 

(/,. Tip: Take care when using the Format Disk option. If a disk containing files is 
~ in the drive during formatting, all its information will be erased. 

To format a disk, follow these steps: 

1. Insert the disk to be formatted in a drive. 

2. Select Format Disk. 

3. A dialog box appears. Left-click on the drive containing the disk to be formatted. 
(Select Cancel or press Return to cancel the operation.) 

4. A second dialog box appears. Select Single to format a single-sided disk, or Double to 
format a double-sided disk. (Select None or press Return to cancel the operation.) 

5. The disk is formatted and you return to the canvas. 

Quit 

Select the Quit option to leave the Art Director program and return to your system 
desktop. A dialog box reminds you to save your changes before quitting. Press Y (for 
Yes) to leave the program and return to your desktop. Press N (for No) to return to your 
canvas. 
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Effects Menu Options 
The Effects menu contains options for manipulating a defined section of your canvas to 
create a new brush. When an option is selected, its name appears in the upper left corner 
of your screen. 

Images created by Effects menu options become brushes, and can be stamped repeatedly 
or painted on the canvas. They can also be modified with the options in the brush's 
selection box to create particular effects. 

For example, you can stretch an image with the Stretch option described in this section. 
The stretched image becomes a brush. By using a dark color from the palette and the 
Silhou option from the brush's selection box, you can turn the stretched image into a 
shadow and stamp it near the original image for a shadow effect. 

c/' Tip: Press Esc to cancel an image that's being redrawn by an Effects menu 
~ option. The partially drawn image becomes your brush. 

Rescale 
The Rescale option enlarges or shrinks a selected part of your painting and uses the 
resulting image as a brush. With Rescale you can change the size of an image but you 
cannot change its relative proportions. 

Select Rescale, then left-click on OK or press Return in the warning box. Flashing 
crosshairs appear on your canvas. To create a rescaled brush, follow these steps: 

1. Place the center of the crosshairs in the upper left comer of the area you want to 
rescale and left -click to set this point. 
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2. Move your mouse to see a flashing box. As you continue moving the mouse, the box 
surrounds an area of your canvas. Left-click when the box is set over the area you 
want. 

r:?,. Tip: If the source area you last defined was a rectangle, you can use it again 
~ now by pressing Alternate 0 instead of redefining that area. 

3. The crosshairs reappear. Now set the image's new size. Move the center of the 
crosshairs anywhere on your canvas. When you left-click, the center becomes the 
upper left comer of the new area. Move the mouse until the flashing box is the correct 
size, then left-click. The image is reproduced in the new size and becomes your brush. 

4. Move your mouse to position the image, then left-click to stamp the image on the 
canvas. 

,. Tip: When setting the image's new size (step 3), move the mouse downward and 
~(/ to the right to create a normal image, upward to create an upside-down image, 

and to the left to create a flipped image. 

Rescale can be used to correct errors in proportion. For example, if you draw a human 
body, use Rescale to correct an out-of-proportion body part without having to redraw it. 

Stretch 

The Stretch option alters the relative proportions of an image. For example, you would 
use Stretch on an image that is the correct scale for its surroundings, but you want it fatter 
or longer. With the Stretch option, the image you create becomes a brush. 

Select Stretch, then left-click on OK in the warning box (or press Return). Flashing 
crosshairs appear on your canvas. Then follow these steps: 

1. Place the center of the crosshairs in the upper left comer of the area you want to stretch 
and left -click to set this point. 

2. Move your mouse to see a flashing rectangle. As you continue moving the mouse, the 
rectangle surrounds an area of your canvas. Left-click when the rectangle is set over 
the area you want. 

,. Tip: To use your current brush for the source image, press Alt 0 in place of 
~c/ defining an image in step 2. When your brush appears, left-click. 

,. Tip: If the source area you last defmed was a rectangle, you can use it again 
~c/ now by pressing Alternate 0 instead of redefining that area. 
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3. The crosshairs reappear. Now set the image's new size. Move the center of the 
crosshairs anywhere on your canvas. When you left-click, the center becomes the 
upper left comer of the new area. Move the mouse until the flashing rectangle is the 
correct size, then left-click. The image is redrawn in the new size and becomes your 
brush. 

4. Move your mouse to position the image, then left-click to stamp the image on the 
canvas. 

,- Tip: When setting the image's new size (step 3), move the mouse downward and 
~c/ to the right to create a normal image, upward to create an upside-down image, 

and to the left to create a flipped image. 

Distort 

The Distort option lets you skew a portion of your canvas into another shape. The image 
you create becomes a brush. With Distort, you can create interesting surrealistic images, 
shapes, and patterns. 

Select Distort, then left-click on OK in the warning box (or press Return). A small arrow 
appears which you will use to define a four-sided shape. Follow these steps: 

1. Decide on the area you want to distort, then outline it by setting points. Move the 
mouse to place the arrow on your first point in the outline. Left-click to set the point. 

2. Move the arrow to a second point. A flashing line forms between the two points. Left­
click to set point two. 

3. Move the arrow to a third point. The flashing line becomes a three-sided shape. Set the 
third point with a left-click. 

4. Move the arrow to a fourth point. A four-sided shape now defines the area that will be 
distorted. Left-click. The flashing shape disappears. 

5. Begin defining an area for the distorted image. Set four new points by moving the 
arrow and left-clicking, as in the previous steps. If you defined a regular shape, such as 
a square, for the source image (steps 1 through 4), you may want to set points for an 
irregular shape, such as a trapezoid, for the distorted image. 

6. Once you set the fourth point, the image is redrawn in the distorted shape and is 
available as a brush. 

" Tip: When redrawn, an image will always begin at the first point you set. For 
~(/ example, suppose you set the first point of your source image at its upper left. 
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Rotate 

The Rotate option turns a portion of your canvas around an axis to the orientation you 
want. The image created with Rotate becomes a brush. 

Use Rotate to create similar images with different orientations for use in Film Director 
animations. For example, Rotate can help you create images for an animation of an 
athlete swinging on a parallel bar, or a runaway tire rolling downhill. 

Select Rotate, then left-click on OK in the warning box (or press Return). Flashing 
crosshairs appear on your canvas. Then follow these steps: 

1. Place the center of the crosshair in the upper left comer of the area you want to rotate 
and left-click to set this point. 

2. Move your mouse to see a flashing box. As you continue moving the mouse, the box 
surrounds an area of your canvas. When the box is set over the area you want, left­
click to set it. 

,. Tip: If the source area you last defined was a rectangle, you can use it again "c? now by pressing Alternate 0 instead of redefining that area. 

3. A guide bar appears with its end at the center of the rectangle. 

Move the mouse to rotate the guide bar and box to the orientation you want for the 
redrawn image. When the guide bar points to the center right edge of the canvas, the 
image will be redrawn right side up. When the guide bar points to the left center edge, the 
image will be redrawn upside down. 

4. When the guide bar and box are positioned, left-click. The image will be redrawn as a 
brush that you can stamp or paint with anywhere on the canvas. 

Bend 

The Bend option wraps a section of your painting around an imaginary cylinder. Use 
Bend to achieve a three-dimensional effect. For example, use Bend to wrap the word 
"soup" around a can, or make columns on the front of a building look cylindrical. The 
image created with the Bend option becomes your brush. 

c' Tip: During a Bend operation, Art Director may take several seconds to draw 
~ the bent image on your canvas. 

Select Bend, then left-click on OK in the warning box (or press Return). Flashing 
crosshairs appear on your canvas. Follow these steps: 

1. Place the center of the crosshairs at the upper left comer of the area you want to bend 
and left-click to set this point. 

47 



2. Move your mouse to see a flashing box. As you continue moving the mouse, the box 
surrounds an area of your canvas. Left-click when the box is set over the area you 
want. 

' Tip: If the source area you last defined was a rectangle, you can use it again 
~(/ now by pressing Alternate 0 instead of redefining that area. 

3. Small crosshairs appear. Move the crosshairs anywhere on the canvas and left-click to 
set the first point of an axis line for your imaginary cylinder. 

4. Move the crosshairs at any angle to the point you just set. A flashing line--the axis 
line--appears. Left-click when the crosshairs are where you want to end the line. 

5. When you move the mouse now, two curves appear, one at each end of the axis line. 
These curves represent the circumference of the imaginary cylinder. Move the mouse 
in any direction to size the curves--wider, narrower, above, or below the ends of the 
axis line. When the curves look good, left-click. 

6. The image is redrawn, bent around the cylinder you defined, and becomes your brush. 

' Tip: The bending effect is very apparent when the bent area includes a pattern. 
~(/ 

Bulge 

The Bulge option wraps an image on or in an imaginary sphere. You can use Bulge to 
draw both a convex soccer ball and a concave reflection in a metal bowl. 

Select Bulge, then left-click on OK in the warning box (or press Return). A small arrow 
appears. Now follow these steps: 

1. Decide on the area you want to bulge, and move the arrow to its center. Left-click to 
set this center point. · 

c:>' Tip: If the source area you last defined was a circle, you can use it again 
~ now by pressing Alternate 0 instead of redefining that area. 

2. A flashing circle appears that you can expand and contract by moving the mouse. Drag 
this circle to the desired circumference of your sphere and left -click to set it. 

3. A second flashing circle appears inside the circumference. Move the mouse to expand 
or contract this circle. If you want the bulge to appear convex (like a ball), set the inner 
circle's size to almost equal the outer one's. If you want the bulge to appear concave 
(like the inside of a bowl), make the inner circle smaller than its original size. Left­
click to set the inner circle. 

c:>' Tip: You can't make the inner circle larger than the outer circle. 
~ 
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4. Art Director draws the bulge which becomes your new brush. 

,. Tip: The bulge is very apparent when the bulged area includes a pattern. 
~(/ 

Perspective 

The Perspective option alters the perspective of a selected image. This option is useful for 
adding depth to a painting or creating a realistic scene such as railroad tracks heading into 
the distance. 

,. Tip: When you use Perspective, Art Director may take several seconds to draw 
~(/ the altered image. 

Select the Perspective option, then left-click on OK or press Return in the warning box. 
A dialog box appears asking if you want to set a new vanishing point. Left -click on Yes if 
you do. (Left-click on OK or press Return to retain a previously set vanishing point.) 

(/,. Tip: The vanishing point is where converging lines in a painting will apparently 
~ meet. 

Four flashing lines appear radiating from a common vanishing point. Now follow these 
steps: 

1. Move the mouse to position the vanishing point and left-click to set it. Flashing 
crosshairs appear. 

2. Define the image from your canvas that will have its perspective altered. Move the 
mouse to position the center of the crosshairs at the upper left comer of the image and 
left-click. When you move the mouse, a flashing box appears. Move the mouse to size 
the box until it surrounds your image, then left-click to set it. 

(/,. Tip: If the source area you last defined was a rectangle, you can use it again 
~ now by pressing Alternate 0 instead of redefining that area. 

3. A line appears radiating from your vanishing point. The end of the line represents 
where the upper left comer of your source image will be drawn. Move your mouse 
until the line's end is where you want it, then left-click. 

4. Move the mouse again. A flashing triangle appears, representing the width of the final 
image. Adjust the triangle by moving your mouse, then left-click when the triangle is 
the size you want. 

5. Move the mouse. A flashing box appears representing the height of the final image 
(that is, how far the image will reach from its end point, set in step 3, towards the 
vanishing point). Adjust the box to the depth you want and left-click to set it. 

6. The final image is drawn and becomes your brush. 
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Tools Menu Options 
The Tools menu contains options that are used as painting tools, similar to the tools in the 
toolbox. Options from the Tools menu are used less frequently than toolbox tools, but 
produce more complex effects, such as color smearing and outlining. 

When you select an option, its name appears in the message in the upper left comer of 
your screen. To exit from an option, select a toolbox feature or another option from the 
Effects or Tools menu. 

Spray Can 

The Spray Can option randomly sprays a mist of color on your canvas. Using the Spray 
Can, you can create a starry sky, for example. 

When you left-click on the option, a selection box appears. 
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Tool Size Your selection determines the size of your spray can nozzle when 
used with the pencil. 

Effect Your selection sets the rate at which color is sprayed. Select Slow for a 
very fine mist; select Fast for heaviest coverage. 

Make your selections and left-click on OK or press Return. If you're using the pencil, a 
flashing circle (the spray can nozzle) appears. Hold down the left mouse button and move 
the mouse to spray. The color you spray will be the color currently showing in the color 
swatch. 

If you're using the brush, a flashing box appears. Again, hold down the left mouse button 
and move the mouse to spray. The result will be a spray of colors from the brush. 

" Tip: Holding down the left mouse button without moving the mouse will 
~c/ eventually spray your brush on screen as though you stamped it. 

Smear 

The Smear option lets you "rub" the canvas, mixing up pixels of different colors. Doing 
this creates a smeared or smudgy look. Left-click on the option and a selection box 
appears. 

Tool Size Your selection determines the size of your smearing tool. 

Make your selection and left-click on OK or press Return. Flashing crosshairs appear. 
Move the crosshairs to an area on your canvas where two or more colors meet--for 
instance, where a row of hills meets the horizon. Then hold down the left mouse button 
while moving the crosshairs over the area. Pixels of the different colors will change 
places within the area, achieving a hazy look similar to a watercolor wash. 

Scrape 

The Scrape option lets you scrape through an image on your front page to reveal an 
image on your back page. When you're creating frames for animation, use Scrape to 
achieve the effect of gradually revealing parts of another scene, or merging two scenes. 
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When you select Scrape, a selection box appears: 

Tool Type Choose Spray if you want to scrape away an image pixel by pixel 
for a misty effect. Choose Solid to scrape away an image in blocks. The Spray 
cursor is a flashing circle; the Solid cursor is a flashing box. 

Tool Size Select a size depending on the area you want to scrape away with 
each stroke. 

Make your selections and left-click on OK or press Return. Position the cursor on the 
area of your canvas you want to scrape away. Then hold down the left mouse button 
while moving the mouse to scrape. The underlying image from your back page will be 
exposed in the scraped area. 

,. Tip: Scrape uses the palette of your front page, and images from the back page 
~(/ will be revealed in those colors. For best results, the palettes of both your front 

and back page should be the same or at least similar. 

Melt 

The Melt option blends colors together. Left-click on the option and a selection box 
appears. 

Tool Size Your selection determines the size of your melting tool. 

Make your selection and left-click on OK or press Return. A flashing box appears. Move 
the box to an area on your canvas where two or more colors meet--for instance, where the 
top of a tree overhangs a roof. Then hold down the left mouse button while moving the 
box over the area. Pixels of the different colors will change places within the area, 
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achieving a drizzly look. In the case of a treetop overhanging a roof, the effect will be as 
if a breeze were blowing the leaves. 

Shade 

The Shade option sprinkles pixels of a darker or lighter shade onto a selected color in 
your painting. Left-click on the option and a selection box appears: 

Actual Color Your selection determines if the sprinkled pixels will be a shade 
darker or lighter than the color in the color swatch. 

Tool Size Your selection determines the size of your shading tool. 

Make your selections and left-click on OK or press Return. A flashing box appears. 
Move the cursor onto the palette and left-click on the color you want to shade. That color 
appears in the color swatch. 

Move the cursor back onto the canvas, hold down the left mouse button, and move the 
mouse. When the flashing box moves over the color-swatch color on your canvas, pixels 
of color will be sprinkled onto it. The color sprinkled will be the color from your palette 
that is the closest shade (lighter or darker) to the actual color. 

(?,. Tip: The Shade option does not create lighter or darker colors--it chooses them 
~ from the palette. For example, suppose the color in your color swatch is yellow, 

but there are no other lighter or darker yellows in the palette. When you use 
Shade, Art Director will sprinkle pixels of the closest color from the palette, 
such as brown, tan, or orange. 
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Xcolor 

The Xcolor option substitutes or swaps one color on your canvas for the color in the color 
swatch. Left-click on the option and a selection box appears. 

Replace Select this option to substitute one color on the canvas for the color in 
the color swatch. For example, if you've painted a green house under a blue sky, 
use Replace to paint the house blue. 

Exchange Select this option to swap two colors on the canvas, so that each 
color replaces the other. For example, if you've painted an orange house under a 
blue sky, use Exchange to repaint the house blue and the sky orange. 

Make your selection and left-click on OK or press Return. An arrow appears. Move the 
cursor onto the palette and left-click on a color. That color appears in the color swatch. 
Move the cursor back onto the canvas, place the point of the arrow on the color you want 
to affect, and left-click. 

If you're replacing a color, the color in the color swatch will be substituted for the color 
pointed to throughout your canvas. If you're exchanging colors, all occurrences on the 
canvas of the color in the color swatch and the color pointed to will swap places. 

Col Merge 

The Col Merge option merges a single color from one canvas onto another. This option is 
helpful when you want to duplicate a one-color image, such as text, an outline, or a 
silhouette, from one canvas into the exact spot on another canvas. 

(/,. Tip: Images copied with Col Merge are not brushes. They cannot be easily 
~ relocated on the second canvas once they are duplicated onto it. 

Follow these steps: 

1. Select Col Merge from the Tools menu. Move your cursor onto the palette and left­
click on the color of the image to be duplicated. 

2. Move the canvas to the back page. Now load a new canvas onto the front page (or use 
the blank canvas). 

3. Left-click anywhere on the canvas. The color from the back-page canvas will be 
duplicated into the same location on the front-page canvas. 

,. Tip: Col Merge uses the palette of your front page, and images from the back 
~<;;? page will be duplicated in those colors. For best results, the palettes of both your 

front and back pages should be the same or at least similar. 
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Outline 

The Outline option outlines images on your canvas with the color in the color swatch. 
Left-click on the option and a selection box appears: 

One Color Left-click on Outline to outline all shapes of a single color with the 
color in the color swatch. The outline surrounds the shape and leaves the 
original color intact. 

All Colors Left-click on a contrast level to draw an outline of a shape and erase 
its original color. A shape is outlined depending on its level of color contrast 
with the colors that surround it. 

o Select Faint or Slight to outline shapes that contrast slightly with surrounding 
colors. 

o Select Medium to outline shapes that have a medium contrast with their 
surrounding colors. 

o Select Strong or Sharp to outline all shapes that contrast sharply with their 
surrounding colors. 

Make your selections and left-click on OK or press Return. Select the color from the 
palette that you want as your outline color. Then, if you selected One Color Outline, 
move the arrow onto a shape that is in the color you want outlined and left-click. If you 
selected All Colors and a contrast level, move the cursor anywhere on the canvas and 
left-click. 

The toolbox disappears during outlining and reappears when outlining is complete. 
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Round Off 

The Round Off option smoothes sharp angles in a painting to achieve a softer look. Left­
click on the option and a selection box appears: 

Facet Select a level--Fine, Medium, or Rough--to determine to what degree the 
angles will be rounded. Fine gives the least amount of rounding; rough gives the 
most. 

Make your selection and left-click on OK or press Return. Then left-click anywhere on 
the canvas. The toolbox disappears during rounding off and reappears when the operation 
is complete. 

Window 

The Window option defines an area, or window, on your canvas. Once a window is 
defined, the bucket tool and Xcolor, Col Merge, Outline, and Round Off options will 
affect only that area. 
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Left-click on Window and a selection box appears: 

Window Select On to activate a window. Select Off to deactivate a window 
currently on your canvas. 

Top Left X,Y Shows the location of the window's upper left corner, in pixel 
coordinates. 

Bottom Right X, Y Shows the location of the window's bottom right corner, in 
pixel coordinates. 

Define New Window? Select Yes if you want to set a new window. When the 
canvas reappears, flashing crosshairs are on screen. Move the center of the 
cross hairs to the upper left corner of the window area you want and left-click. 
Then move the mouse to stretch a flashing box around the area. When the lower 
right comer of the box is where you want it, left-click. 

Use Old Select OK or press Return to re-activate the last window you set, 
defined by the pixel coordinates given in this selection box. Window must be set 
to On in order for this option to work. 

When a window is active, select a tool or option (such as the bucket tool or Col Merge), 
move the cursor into the window, and left-click. This action will affect only the canvas 
area within the window. 

The window remains active until you tum it off. Select the Window option again, left­
click on Off, then left-click on OK or press Return. 

o' Tip: Press Alternate W to toggle a window on and off. 
~ 
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Grid 

The Grid option places an invisible grid over your canvas. Tools lock onto the grid's 
intersections. A grid helps you draw precise lines or arrange shapes in a precise pattern. 
The grid is also useful for creating graphs, charts, checkerboards, or any pattern that 
requires straight lines and right angles. 

Left-click on Grid and a selection box appears: 

Grid Select On to activate a grid. Select Off to deactivate a grid currently on 
your canvas. 

Size X,Y This item gives the size of the upper left box of your grid. The upper 
left comer of this box is always at location 0,0 on your canvas. The bottom right 
comer is at the pixel coordinates shown here. 

Define New Grid? Select Yes if you want to set a new grid. When the canvas 
reappears, a flashing grid with a cross-like cursor is on screen. Move the cursor 
to enlarge or reduce the boxes in the grid. The grid covers the entire canvas even 
if its visible portion covers only part of the screen. Most of the grid is invisible 
when its boxes are small and its intersections are close together. 

When the grid is the size you want, left-click to set it. The grid disappears and 
becomes active. 

Use Old Select OK or press Return to re-activate the last grid you set. 

,. Tip: You must move or hide the toolbox in order to set a grid that's narrower 
~(/ than 24 pixels across. 
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The grid remains active until you turn it off. Select the Grid option again, left-click on 
Off, then left-click on OK or press Return. 

Special Menu Options 
The Special menu contains miscellaneous options both for achieving special effects on 
your canvas and for controlling the components on the Art Director screen. 

Use Brush Color 

The Use Brush Color option is helpful when you're using a brush that you created on 
another canvas having a different palette. Select Use Brush Color to change the current 
palette to the one that was originally used to create your brush. The two paintings then 
have identical palettes. · ' ' 

r:?' Tip: The canvas where your brush was originally created does not have to be on 
~ your back page. 

Use Back Color 

The Use Back Color option lets you change your palette to the one currently on your back 
page. Select the option to bring the back page palette onto your current canvas. The two 
canvasses will then have identical palettes. 
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Copy Page Back 

The Copy Page Back option duplicates your current canvas onto the back page, while 
retaining it on the front page. This option is handy when you want a backup copy of your 
current canvas within easy reach. · 

r:?' Tip: All palettes set for your current canvas from the front palette editor are 
~ copied to the back page with this option. 

View Pages 

Select View Pages to see both your front and back pages at the same time. The front page 
is on top, and the front page palette is used. The letters to the left of the pages tell their 
position in your page map. 

The View Pages screen is a viewing screen only; you can't make any changes on it. Left­
click to return to the Art Director screen. 

Cycle Color 

The Cycle Color option cycles different palettes through your painting. The palette colors 
and timing are set from the palette editor. For details, see Palette Editor earlier in this 
manual. 

Press any key or click either mouse button to tum off color cycling. 

Sprite 

The Sprite option defines a circle on your canvas and makes it bounce around the screen. 
Left-click on the option and a selection box appears: 
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Define New Sprite? Select Yes if you want to create a new sprite. When the 
canvas reappears, a small arrow is on screen. Follow these steps: 

1. Move the arrow to the center of an image, press the left mouse button, and 
move the mouse. An oval appears. 

2. Move the mouse until the oval surrounds the image, then left-click. Your 
cursor goes to the center of the oval. 

3. Move the mouse to extend a line that indicates the direction and speed of the 
sprite's first move. The longer the line, the faster the sprite. 

4. Left-click to start the sprite moving. The back page appears, with the sprite 
bouncing in it and using the palette from the front page. When the sprite 
bumps an edge of the canvas, it bounces off in another direction. 

Use Old Select OK or press Return to reactivate the sprite already created. In 
order for this selection to work, the canvas with the sprite must be on the front 
page. 

Press any key or click either mouse button to stop the sprite and return to the front page. 

c:>' Tip: The image you define as a sprite also becomes a brush. 
~ 

Spin 

The Spin option defines a rectangular area on your canvas and makes it spin around its 
axis, either horizontally or vertically. Left-click on the option and a selection box 
appears: 

\ 
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Spin Select either Horizontal or Vertical to set the direction of spin. Your 
choice affects only the next sprite you define. It does not affect a previously 
defined sprite. 

Define New Spin? Select Yes if you want to set up a new spinning image. A 
warning box appears. Left-click on OK or press Return if you don't mind 
overwriting the back page. If you do, select Cancel and save your back. page 
before creating a spinning image. 

When the canvas reappears, a flashing box is on screen. The box indicates the 
maximum possible size of the spinning image. Move the top left arrow of the 
box to where you want it and left-click. Move the mouse until the box surrounds 
the spinning image you want, and left-click. In a few moments, the spinning 
image appears on your canvas. The image is also put on your back page. 

Use Old Select OK or press Return to re-activate the spinning image already 
created. In order for this selection to work, the canvas with the spinning image 
must be on the back page, and the back page must not have been changed since 
you defined the spinning image. 

You can move the spinning image on the canvas by moving your mouse. Press any key or 
either mouse button to make the spinning image disappear. 

Warnings 

The Warnings option lets you toggle various warning messages on and off. Left-click on 
Warnings and a selection box appears: 
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File Overwrite This message warns that you are about to write over an existing 
file, and appears when you saving a painting under an existing filename. 

Front Page Ow. This message warns that you are about to write over your 
front-page canvas, and appears when you are loading a file or flooding your 
canvas with color. 

Back Page Ow. This message warns that you are about to write over your back 
page canvas, and appears when you use the Copy Back Page and Spin options. 

Brush Change This message warns that you are about to replace your brush 
with another brush. It appears if you already have a brush selected and choose an 
option that lets you create another brush. 

Set each selection to Off or On by clicking on either word. Off means the warning box 
will not appear during your Art Director session; On means the warning box will appear. 
Then select OK or press Return. 

Your selections can be saved to disk with the Save Prefs option in the File menu. 

Restrict Cursor 

The Restrict Cursor option keeps your cursor within the visible canvas. To deactivate the 
option, display the Special menu and select Free Cursor. You'll then be able to move your 
cursor off screen--for example, in order to look at a painting without the cursor in it. 

r:/11' Tip: If you lose the cursor, press Help to return it to the center of the canvas. 
~ 

Hide Toolbox 

The Hide Toolbox option removes the toolbox from your screen. To redisplay the 
toolbox, display the Special menu and select Show Toolbox. • 

Using ARTCONV.PRG 
With Art Director, you can use picture files created with NEOchrome or DEGAS Elite. 
To do that, you must first convert those files to .ART files using the program 
ARTCONV.PRG (supplied on the Art Director disks). Follow these steps: 

1. From the GEM Desktop, run ARTCONV.PRG. The program loads and displays its 
menu bar offering four selections: Desk, File, Input, and Output. 

2. Insert a disk containing aNEOchrome (.NEO) or DEGAS Elite (.Pil) picture file into a 
disk drive. 
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3. Display the Input menu and select the type of file you want to load. 

4. Display the File menu and select Load Picture. An item selector appears listing 
picture files. 

,. Tip: If you need to, edit the directory line in the item selector to display the 
~(/ correct drive letter and folder (if any). Left-click on the scroll bar in the item 

selector to update the directory list. 

5. Left-click on the file you want to convert, then left-click on OK or press Return. The 
file is loaded into memory. 

6. Display the Output menu and select the type of file you want to convert to. 

7. Display the File menu and select Save Picture. An item selector appears. 

8. If you want, edit the filename on the selection line, but do not change the filename 
extension. Select OK or press Return to save the file. 

You now have two picture files on disk: the original file and the converted file. 

Select Quit from the File menu to exit the program. The File menu also contains the 
Delete File and Format Disk options. Use them in the same way you use the Delete File 
and Format Disk options in Art Director. 

Using ARTSHOW.PRG 
ARTSHOW.PRG lets you display your Art Director paintings one by one in a slideshow. 
From your GEM Desktop, copy the file ARTSHOW.PRG (supplied on the Art Director 
disks) to any disk containing .ART files. When you want to watch a slideshow of the 
files, insert that disk into a drive and run ARTSHOW.PRG from the desktop. The 
program will display all .ART files on the disk, one at a time. 

' Tip: If your .ART files are in a folder, copy ARTSHOW.PRG into the folder 
~(/ with them. To watch the slideshow, run ARTSHOW.PRG from the folder. 

During the slideshow, press the Left Arrow to watch your slideshow in reverse. Press the 
Right Arrow to return to forward showing. Press the Down Arrow for forward color 
cycling; press the Up Arrow for reverse color cycling. -

Press Spacebar to pause the slideshow; press it again to resume. Press Esc to exit the 
program and return to the GEM Desktop. 
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ART DIRECTOR 
KEYBOARD SHORTCUTS 
With Art Director, you can make selections from the keyboard instead of using your 
mouse. Press the following keys for the selection listed next to each key. 

' Tip: Alt indicates the Alternate key. Ctrl indicates the Control key. 
~r:;:::> 

General Use 
Alt 

Shift 

Control 

Esc 

Alt Esc 

Help or Ctrl B 

Return 

Alt Return 

Arrow keys 

Alt Arrow keys 

Delete 

Ctrl U 

Ctrl D 

Hold down to prevent horizontal cursor movement. 

Hold down to prevent vertical cursor movement. 

Displays a pixel's RGB value in the upper right corner of the 
canvas while using the pencil and the freehand or line-draw 
tool. 

Interrupts and cancels an operation; completes the entering of 
text; exits zoom display. 

Displays the menu bar. 

Places cursor at screen center. 

Usually the same as left-clicking on OK (except when another 
selection is highlighted by default). Enters carriage return 
when typing text. 

Same as holding down the left mouse button. Pre£s Return 
again to release function. 

Move cursor one pixel in indicated direction. 

Move cursor eight pixels in indicated direction. 

Floods the canvas with the currently selected color. 

Moves the canvas up one pixel. 

Moves the canvas down one pixel. 
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Toolbox 
Alt/ 

Alt Spacebar 
or Alt. 

Alt, 

Fl 

F2 

F3 

F4 

FS 

F6 

F7 

FS 

F9 

Ctrl X 

Undo 

Pencil 

Brush 

Pencil · 

Eraser 

Freehand 

Line-draw 

Bucket 

Text 

Zoom 

Scissors 

Scroll 

Toggles mirror on and off 

Toggles brush cursor on and off 

Swaps front and back pages 

Undo 

First select the pencil (Alt Spacebar or Alt.) and the scissors (F6). Then use these keys 
to select pencil tips: 

Shift R Unfilled circle 

Alt Shift R Filled circle 

R Unfilled oval 

AltR Filled oval 

ShiftS Unfilled square 
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Alt ShiftS 

s 

Alt S 

Brush 

Filled square 

Unfilled rectangle 

Filled rectangle 

First select the brush (Ait (). Then use these keys: 

Alt * or Alt Shift 8 Transparent 

Alt-

Ait + or Alt Shift = 

Ctrl Q 

Ctrl S 

Alt Ctrl S 

z 

Shift Z 

Shift X 

ShiftY 

X 

y 

T 

Shift T 

Freehand 

Block 

Silhouette 

Assimilate 

Clears brush 

Default brush 

Flip horizontally. (Not active with a text brush). 

Flip vertically. (Not active with a text brush). 

Halve horizontally. (Not active with a text brush). 

Halve vertically. (Not active with a text brush). 

Double horizontally. (Not active with a text brush). 

Double vertically. (Not active with a text brush). 

Tum 90 degrees right. (Not active with a text brush). 

Tum 90 degrees left. (Not active with a text brush). 

First select freehand (Fl). Then use these keys: 

Alt N Smooth line 

Alt Shift N Coarse line 
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Alt 1 

Alt2 

Alt 3 

Alt4 

Line-Draw 

Slow 

Medium 

Normal 

Fast 

First select line-draw (F2). Then use these keys: 

AltL Straight 

AltZ Zigzag 

AltX Rays 

AltS Rectangle 

Alt ShiftS Square 

AltR Oval 

Alt Shift R Circle 

AltP Polygon 

Scissors 
First select the scissors (F6). Then use these keys: 

0 

6 

7 
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Bucket 
First select the bucket (F3). Then use these keys: 

AltF Fill area 

Alt Shift F Fill contour 

Text 
First select text (F4). Then use these keys. 

" Tip: All fonts except regular and half-size fonts must be loaded onto the back 
~c? page before they can be accessed with these keys. 

AltO 

Alt 1 

Alt2 

Alt3 

Alt4 

Alt5 

Alt 6 

Alt7 

Alt 8 

Backspace 

Return 

Altl 

Alt Shift I 

Esc 

Regular font 

Half-size font 

8 x 8 font 

8 x 16 font 

16 x 16 font 

16 x 24 font 

24 x 32 font 

24 x 40 font 

32 x 48 font 

Erases last character entered. 

Moves cursor to next line. 

Inverts the color of the next text you enter. Active only with 
regular and half-size text. 

Restores the next text you enter to the original text color. 
Active only with regular and half-size text. 

Completes the entering of text and converts text to a brush. 

69 



Page Swap 
When the page swap selection box is displayed, press A through P to display page A 
through P (except for whichever page is the current back page). 

Display 
FlO Toggles toolbox on and off 

Tab or Ctrl I Toggles display on and off 

Palette Editor 
First display the palette editor. Then use this key: 

Alt I Inverse color 

Tools Menu 
Press these keys to continue to select options from the Tools menu when a selection from 
that menu was the last action taken. 

AltA Spray Can 

Alt S Smear 

AltC Scrape 

AltM Melt 

Alt [ Shade, light 

Alt] Shade, dark 

AltX XColor, replace 

Alt Shift X XColor, exchange 

AltU Color Merge 

AltO Outline, in the last selected mode 
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AltW Toggles previously set window on and off 

AltG Toggles previously set grid on and off 

Alt 0 (zero) Outline, in selected color 

Alt 1 Outline, faint contrast 

Alt 2 Outline, smooth contrast 

Alt3 Outline, medium contrast 

Alt 4 Outline, strong contrast 

Alt 5 Outline, sharp contrast 

AltQ Round Off 

Effects Menu 
Press these keys to continue to select options from the Effects menu when a selection 
from that menu was the last action taken. 

1 

2 

3 

4 

5 

8 

9 

Alt O 

AltW 

Alt G 

Rescale 

Stretch 

Perspective 

Bend 

Rotate 

Distort 

Bulge 

Uses the source area last defined if compatible with the 
current option. 

Toggles previously set window on and off. 

Toggles previously set grid on and off. 
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Special Menu 
Press the following keys to continue to select options from the Special menu when a 
selection from that menu was the last action taken. 

Ctrl P Use Brush Color 

Ctrl R Use Back Color 

Ctrl K Copy Page Back 

Ctrl V View Pages 

Alt ( or Alt Shift 9 Cycle Color 

Alt ) or Alt Shift 0 Sprite (begin bouncing) 

Alt & or Alt Shift 7 Spin (begin spinning) 

Ctrl F9 Restrict or Free Cursor 

FlO Show or Hide Toolbox 
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USING FILM DIRECTOR 
Film Director uses traditional animation techniques to assist you in creating your own 
films. The many time-saving features Film Director offers, together with the high speed 
of your ST, let you quickly assemble your artwork into colorful and exciting animated 
works. You can then transfer your films to video-tape to use in many ways, from family 
fun to professional product presentations. 

Film animators use a technique called eel animation to animate their artwork. A eel is a 
sheet of transparent celluloid with artwork painted on it. Cels are layered, or stacked, to 
assemble the frames that make up the completed film . Without a computer, the process of 
creating eels and assembling them into a film can be long and tedious. Film Director 
advances the concept of eel animation by having the computer generate many of the 
intermediate steps necessary to create smooth animation. 

A film is a series of still pictures, called frames, that give the illusion of movement when 
viewed in rapid succession. Film Director's frames contain stacks of eels that can be 
manipulated in many ways to speed the animation process. 

Patterns are images cut out of art files from Art Director. They can be anything from 
small images to large blocks of color to body parts used in the construction of characters. 
The cut-out patterns can be used as eels in a frame. A special type of image, called a 
polygon, is a geometric line drawing created in Film Director. 

Patterns and polygons can then be used to build a more complex eel, called a group. A 
group is a single eel that was constructed with multiple patterns and polygons. This is a 
useful element when you want to build an object out of many smaller graphics, but later 
wish to treat the object as a single eel. 

One of the most valuable animation tools Film Director offers is the actor. An actor is a 
series of eels that define an action when viewed in sequence. Each eel in the series is 
called a phase, and it can be a pattern, or a polygon, or a group. Examples of actors are a 
person running, a wheel rolling, or a ball bouncing. ' : 

Using eels, you can design stages for your film. A stage is a backdrop placed behind the 
action in a film. Stages are used most often to provide scenery and other elements of the 
film that are stationary. 

The range of Film Director's power is shown in its ability to create the intermediate 
elements in an animated sequence. This feature is called tweening. Suppose you want to 
show a child dropping a ball in a series of ten groups. All you have to create is the first 
group (the child holding the ball) and the last group (the ball on the ground). Then, when 
you select the Tween option and specify eight groups, Film Director creates the eight 
intermediate groups needed for the ball to appear to fall . The Tween option can be used 
to create intermediate polygons, groups, and stages. 
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Patterns, polygons, groups, actors, and stages are the elements used to create frames. You 
can construct frames one at a time, or work simultaneously on a number of frames that 
are in sequence. For example, with one operation you can change a stage in your film for 
a single frame or a sequence of frames. 

One easy way to make a film with an actor performing on a stage is by using the path 
feature. With it, you define the beginning and end of the path and the number of times 
you want the actor to cycle through all its phases. Within seconds, Film Director creates 
the requested number of new frames with your actor performing as it moves along the 
path you defined. 

The record feature provides another way to add an actor to your film. With this feature 
you record your actor on pre-existing frames, one at a time, specifying the position of 
each phase. 

Once you have an actor defined in your film, you can use the overlay feature to duplicate 
images in different locations. For example, you can quickly transform a single dancer 
performing a high kick into a chorus line. Then you can have the dancers kick in perfect 
synchronization or skew each dancer one frame to achieve a wave effect. You can also 
copy this sequence so the dance lasts as long as you want. 

Add new eels to a sequence by using the interpolate feature. This option tweens the 
elements in your film, but instead of creating new frames, it finds the intermediate images 
from your defined elements and places those eels on your frames. Interpolate is used for 
patterns, polygons, and groups. 

Film Director also offers a layering feature. Layering places a eel under or over another 
eel. For example, by layering eels, you can show a bird flying through the trees, passing 
in front of some trees and behind others. 

You can save your work to disk at any time. When your film is completed you even can 
add sound effects from the music files included with Film Director. 

When you're ready to begin creating a film, load the Film Director program. (For 
directions, see the Getting Started se<;tion earlier in this manual.) 

During loading, the Film Director title screen is displayed. After the program finishes 
loading, its main screen appears. This is where you will begin putting together an 
animated film. 
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- Cursor 
Coordinates (x,y) 

Animation Board - - Toolbox 

Here's a brief summary of the components of the Film Director screen: 

Toolbox The toolbox contains tools for creating your films. 

Message The message shows the option you most recently selected and often 
gives information about it. Blank Object is the message when you load Film 
Director. · 

Animation Board The animation board is where you create your film. 

Cursor Coordinates (x,y) The cursor coordinates tell you the location of your 
cursor in pixels from the upper left comer of the animation board. They behave 
exactly the same as the cursor coordinates in Art Director. 

.:< 

Move the cursor onto the animation board and right-click to display the menu bar at the 
top of the screen. Each of the four menu selections has a list (menu) of options that you 
can use to work on your film. Some of the menu options are used in the Film Director 
Learning Session, next in this manual. Complete details about all menu options are 
included in the Film Director Reference section. Left-click to hide the menu bar. 
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Film Director Demonstration Film 
Watching the Demonstration Film 
A demonstration film is provided on Film Director Disk 2 so you can see some of the 
animation opportunities Film Director offers you. To watch the film , follow these steps: 

1. Load Film Director as explained in Getting Started, earlier in this manual. When the 
main screen appears, remove Film Director Disk I from the drive and insert Film 
Director Disk 2. 

2. Right-click anywhere on the screen to display the Film Director menu bar. 

3. Move the cursor to the File selection to display its menu. Move the cursor down to 
highlight Load Film (the first menu option) and left-click. 

4. The Load Film item selector appears, listing the .FLM (film) files on the disk. 

~ Tip: The item selector your screen displays may list different files than those 
•• shown here. 
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~ Tip : You may be running Film Director Disk 2 from a second floppy disk drive 
•• or a hard disk drive. If so, edit the selection line so you can access that drive. 

Left-click on the selection line, then use the Left Arrow and Backspace keys to 
change A: to the correct drive letter. Move the cursor into the scroll bar and left­
click again. A new directory for the correct drive appears, listing the file 
DEMO.FLM. 

5. Left-click on DEMO.FLM to select it. Then left-click on OK. The file loads and 
displays the first frame of the film. 

6. Right-click to display the menu bar again. 

7. Move the cursor to Options to display its menu. Then move the cursor down to 
highlight Show Film (the last option) and left-click. ·' 

8. A dialog box appears offering direction and speed options. For now, left-click on OK. 
(The options are explained in the Show Film section, later in this manual.) The 
demonstration film begins playing. 

9. Watch the film to see a fully animated sequence, complete with background details, 
created with Film Director. Notice the frame counter running in the upper left corner 
as the animation plays. Right-click at any time to stop the film and display the menu 
bar. 
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Patterns 
When you loaded the demonstration film, you also loaded the graphic images--or 
patterns--that are the building blocks of an animated figure. To look at the patterns, 
follow steps 1 through 5 in the previous section, then continue with these steps: 

1. With the menu bar displayed, move the cursor to Edit and select the Designer option 
from the menu. 

The word "Design" replaces the word "Edit" in the menu bar, showing that you are 
now in Design mode. 

2. Move the cursor to Design and select Patterns from the menu. 
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A screen of images appears. This is picture A, one of two picture files used to create the 
demonstration film DEMO.FLM. The screen also contains a Patterns toolbox and 
flashing crosshair cursor. 

3. Move the cursor into the toolbox and left-click on the words "Picture A." A dialog box 
appears from which you can select any picture used in the creation of the film. 
DEMO.FLM used two pictures: picture A and picture B. 
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4. Left-click on Pict B, then left-click on OK. Picture B appears. 

~ Tip: If your system has only 512K of RAM, the dialog box does not appear. 
•• Instead, picture B appears. 

Pictures A and B contain all the images needed to produce DEMO.FLM's characters and 
props, in all their positions. The images are separate elements of the characters and props, 
and are drawn from every view and orientation needed for the film. These images can be 
cut out as patterns. 

Pictures A and B were created with Art Director and saved as .ART files . Then they were 
loaded into Film Director, where the patterns were cut from pictures and used to create 
the demonstration film. 

You can look at each pattern individually. Follow the steps: 

1. Left-click on# in the toolbox's first row. The Select Pattern dialog box appears. 

2. In the dialog box, left-click on First. Pattern #1 appears on screen, surrounded by a 
flashing box. This pattern has been cut from picture A of DEMO.FLM. 

3. Move the cursor to the toolbox and left-click repeatedly on the> character in <Step> in 
the second row. Patterns from DEMO.FLM will appear sequentially, one at a time. Or, 
hold down the left mouse button while pointing to the > character. Patterns sequen­
tially appear until you cycle through all the patterns used in the demonstration film. 
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Polygons 
Polygons are another basic element used to create an animated film. To look at the 
polygons used in the demonstration film, follow the steps: 

1. Right-click to display the menu bar. You should be in Design mode, with Design as the 
third menu selection from the left. (If it isn't, display the Edit menu and select 
Designer.) 

2. Display the Design menu and select the Polygons option (second from the top). The 
screen displays the Polygons toolbox and the first polygon used in DEMO.FLM. 
Polygons are multi-sided shapes that can be used as elements in your animated film . 
You create polygons using tools from the Film Director toolbox. 

3. Move the cursor into the toolbox and left-click repeatedly on the> character in 
<Step>. Polygons from DEMO.FLM will appear sequentially, one at a time. Or, hold 
down the left mouse button while pointing to the> character. Polygons sequentially 
appear until you cycle through all the polygons used in the demonstration film. 

Groups 
Groups are collections of patterns and polygons. In DEMO.FLM, the parts of the boy are 
collected into groups to make up a complete boy figure. 

To look at the groups, follow the steps: 

1. With the menu bar displayed, move the cursor to Design and select Groups (the third 
option from the top in the menu). The screen displays the Groups toolbox and the first 
group used in DEMO.FLM. 

2. Move the cursor into the toolbox and left-click repeatedly on> in <Step>/ Or, hold 
down the left mouse button while pointing to >. Groups sequentially appear until you 
cycle through all the groups used in DEMO.FLM. 

Groups are created with tools from the Film Director toolbox. Once a group is defined, it 
can be used in your film. 

Actors 
An actor is a series of patterns, polygons, and/or groups. Each phase in the series is 
selected and arranged in such a way that when the series is viewed in rapid sequence, the 
actor appears to move. The boy riding his bicycle is an example of an actor. 
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To look at the actors in DEMO.FLM, follow the steps: 

1. With the menu bar displayed, move the cursor to Design and select Actors. The screen 
displays the Actors toolbox and the first actor used in DEMO.FLM. 

2. Move the cursor into the toolbox and left-click repeatedly on> in <Step>. Or,-hold 
down the left mouse button while pointing to >. Actors sequentially appear until you 
cycle through all the actors used in DEMO.FLM. 

Actors are created with tools from the Film Director toolbox. Once an actor is defined, it 
can be used in your film. 

Stages 
Stages are the background of a film, giving it a feeling of place and atmosphere. Stages 
are composed of patterns, polygons, and groups, and sometimes contain text. 

To see the stages used in the demonstration film, follow the steps: 

1. With the menu bar displayed, move the cursor to Design and select Stages. The screen 
displays the Stages toolbox. 

2. Move the cursor into the toolbox and left-click repeatedly on> in <Step>. Or, hold 
down the left mouse button while pointing to >. Stages sequentially appear until you 
cycle through all stages used in DEMO.FLM. 

Stages are created with tools from the Film Director toolbox. Once defined, stages can be 
used in your film. 

Frames 
The elements created with the Design feature--patterns, polygons, groups, actors, and 
stages--can be put together to create frames. 

To look at all the frames that make up the demonstration film, follow the steps: 

1. Right-click to display the menu bar. You'll be using the Edit menu, so Edit should be 
the third menu selection from the left. If Design is the third selection from the left, 
move the cursor to it to display its menu and then highlight and left-click on the Editor 
option. Edit should now be the third menu selection from the left. 

2. Select Frames from the Edit menu. 
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The screen displays the Frames toolbox and a frame from DEMO.FLM. 

3. Move the cursor into the toolbox and left-click repeatedly on >in <Step>. Or hold 
down the left mouse button while pointing to >. Frames sequentially appear until you 
cycle through all the frames used in the demonstration film. 

As you view the frames, you'll see that each frame is only slightly different from the one 
before it. When the frames are viewed in rapid succession, they create the illusion of 
smooth, continuous movement. Notice that each frame is composed of elements-­
patterns, polygons, groups, actors, and stages--that were defined in Design mode. 

Look at the demonstration film again, now that you have an idea of how it was produced. 
To view the film, display the Options menu and select the Show Film option. Then select 
OK from the dialog box that appears. ·' i 

Film Director Learning Session 
Creating an Animated Film 
This section explains how to create your own animated short subject using Film Director. 
It guides you step-by-step from cutting out patterns to putting together a sequence of 
frames. During the session you will use all of Film Director's toolboxes and gain experi­
ence with more than 40 tools. 

The film you will create contains two parts. In the first part, a boy moves across a forest 
background, doing jumping jacks. All elements for this part will be taken from the Film 
Director demonstration film DEMO.FLM. The second part shows a star appearing 
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apparently out of nowhere. You will produce the elements needed for this part of the film 
using one of the Film Director toolboxes. 

Loading Pictures 

To begin creating your animated short subject, first load the file DEMO.FLM. Follow the 
steps: 

1. With Film Director's main screen displayed, right-click anywhere on screen to display 
the menu bar. 

2. Insert Film Director Disk 2 into drive A. 

3. Move the cursor to the File selection in the menu bar. In the File menu that appears, 
highlight the Load Film option and left-click. 

~ Tip: The item selector on your screen may list different files than those shown 
•• here. 

An item selector appears listing the .FLM (film) files on the disk. 

~ Tip: You may be running Film Director Disk 2 from a second floppy drive or a 
•• hard disk drive. If so, edit the directory line in the item selector so the correct 

drive letter appears in the pathname. Then move the cursor into the scroll bar 
and left-click. Doing this updates your directory listing and displays the file­
name DEMO.FLM. 

4. Left-click on DEMO.FLM in the item selector, then select OK. DEMO.FLM loads and 
its first frame appears. 
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5. Right-click to display the menu bar. Move the cursor to Edit and select the Designer 

option from the menu. 

The word "Design" replaces the word "Edit" in the menu bar, showing that you are 
now in Design mode. 

6. Move the cursor to Options in the menu bar and select Erase Script. 

7. A dialog box appears warning that the erasure cannot be undone. Left-click on Erase. 
The patterns, polygons, groups, actors, stages, and frames (but not the pictures) of 
DEMO.FLM are erased from memory in order for you to create your own film 
elements. 
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Cutting Out Patterns 

Cut out the patterns you are going to use in your animated film. Follow the steps: 

1. Display the menu bar, move the cursor to Design, and select the Patterns option. 

Picture A, containing patterns of heads, torsos, shoes, and hands, appears. The cursor is a 
flashing crosshair. The pattern counter in the second line of the toolbox reads #0. 

You will cut out the ten patterns shown from pictures A and B in order to make your 
animated film: 
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~ Tip: The toolbox and message on screen hide some patterns. Press FlO to 
•• remove the toolbox and Tab to remove the message. Press the same keys again 

to return the toolbox and message to the screen. 

2. Move the mouse to place the crosshair immediately above and to the left of the third 
head in the top row. Left-click to set the crosshair. 

3. Move the mouse to drag a flashing box around the head. Make sure the right side of the 
box is immediately to the right of the head, and the bottom of the box is immediately 
under the head. Then left-click to cut out the first pattern. 

~ Tip: If you set the beginning angle of the flashing crosshair in the wrong 
•• position, use Undo to cancel the action and begin again. If you set the ending 

angle of the box in the wrong position, cut out that pattern, then cut-out the 
correct pattern. You'll be able to edit your patterns later. ,, 

4. Left-click on Cut in the toolbox to reset the crosshair. When you move the cursor out 
of the toolbox, the crosshair reappears. 

5. Repeat steps 2 to 4 to cut out all the patterns you need from picture A. When you cut 
out the shoe patterns, be sure to cut out each shoe separately. Each time you cut out a 
pattern, the pattern counter in the second line of the toolbox increases by one. 

6. Left-click on Picture A in the toolbox. 

7. In the dialog box that appears, left-click on Pict B. Then left-click on OK. Picture B 
appears. 

~ Tip: In systems having only 512K of RAM, the dialog box does not appear. To 
•• display picture B, left-click on Picture A in the toolbox. 
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8. Select Cut from the toolbox. Then repeat steps 2 through 4 to cut out the tree trunk and 
treetop patterns. 

Make a large blue rectangle to represent the sky in your film . Follow the steps: 

1. Left-click on the sky-blue color in the palette at the bottom of the toolbox. The 
animation board turns sky-blue. 

2. Cut out a rectangle that is the width of the animation board but only half as high. If you 
need to, press FlO to hide the toolbox. 

3. Press FlO again to show the toolbox. Move the cursor onto the toolbox and left-click 
on Picture B to return it to the screen. 

To see the patterns you cut out, left-click on< in <Step> in the toolbox. Look through all 
your patterns. If a pattern is incorrect you can delete it. When the pattern is on screen, 
left-click on Rearrange. In the dialog box that appears, left-click on Delete, then left-click 
on OK in the warning box. The pattern is deleted. 

If you need to make a replacement pattern, return to the appropriate picture and cut out 
the pattern again. The new pattern is assigned the last number in the pattern series. 

~ Tip: You've used several options in the Patterns toolbox. For a complete 
•• description of all the options, see Film Director Refer ence later in this manual. 

Making Polygons 

Polygons are line drawings used primarily as props or backdrops in a film. To draw a 
polygon, follow these steps: 

1. With the menu bar displayed, move the cursor to Design and select Polygons from its 
menu. The screen goes blank and the Polygon toolbox appears. 

2. Left-click anywhere on the animation board to set the first point. 

3. Move the arrow. A line follows it from the first point. Position the arrow and left-click. 

4. Move the cursor and left-click again for each subsequent point. 

5. Double-left-click on the last point to finish the polygon. The palette appears in the 
toolbox. 

6. To change the shape of the polygon, move the cursor to a side or angle of the polygon 
and hold down the left mouse button. The arrow changes to a hand pinching the side or 
angle. 

7. Move the mouse to drag the side or angle to a new location. (When you drag a side, 
you create a new angle.) 
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8. Release the mouse button to set the shape. 

9. Left-click on Undo in the toolbox to erase the polygon. Then follow steps 1 through 8 
to draw a large star for the second part of your film. 

With Film Director, you can generate a series of images between elements in order to 
achieve animation. The greater the number of images, the smoother the animation looks. 
Do this with your star to make it seem as if the star grows from nowhere. Follow the 
steps: 

1. Left-click on Edit in the Polygon toolbox. A dialog box appears. 

D., I 

• 1 
< STEP > 

EDIT 
UNDO 
ST~> 

CYCLE NUHBER 811 •• I..IDI II 
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llllof:Llllf:U. II 

2. Left-click on Single. A second dialog box appears. 
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3. Left-click on Insert. In the next dialog box, left-click on OK. A blank animation board 
appears. This is polygon #1. Your star has become polygon #2. 

4. Left-click on> in <Step> to see polygon #2. 

5. Left-click on Edit in the toolbox. Its dialog box appears. 

6. Type "5" to indicate the number of intermediate stars to be created. The number 05 
appears in the dialog box. 

7. Left-click on OK. A second dialog box appears. 

8. Left-click on Tween, then left-click on OK in the next dialog box. Five in-between 
stars are generated. Your star appears on screen as polygon #7. 

9. Look at all the animation effect by pointing to < in <Step> and holding down the left 
mouse button. 

Forming Groups 

Now use your pattern to create these groups: 

• A tree made up of two patterns--the tree trunk and treetop. 

• Two boys, each consisting of six patterns--a head, torso, two hands, and two shoes. 

To create the tree group, follow these steps: 

1. Display the Design menu and select the Groups option. The Groups toolbox appears on 
a blank animation board. 

2. Left-click on Cel in the toolbox. A dialog box appears. 

3. Left-click on Insert in the dialog box; The Layer, Pattern, and Polygon tools are added 
to the bottom of the Groups toolbox. 

4. Left-click on < in <Pattern> until the tree trunk appears. 

5. Move the arrow onto the tree trunk. Hold down the left mouse button and drag the tree 
trunk around the animation board. When the tree trunk is where you want it, release 
the mouse button. 

Repeat steps 2 to 5 to select and place the treetop on the tree trunk. You have now created 
a group. 
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To define a different group, you need to start with a blank animation board. Follow the 
steps: 

1. Left-click on Edit in the Groups toolbox. A dialog box appears. 

2. Left-click on OK. A second dialog box appears . 

3. Left-click on Insert, then left-click on OK in the third dialog box. The screen displays a 
blank animation board. 

4. Following the same steps you used to create a tree group, create the two boy groups 
shown below: 

The two boy groups have some common patterns. When creating the groups, you can 
save time by duplicating the common patterns, then adding the patterns that.are different. 
Follow these steps: · · 

1. Create the first boy group. 

2. Copy this group by left-clicking on Edit in the toolbox. A dialog box appears . 

3. Left-click on OK, then left-click on Copy in the second dialog box. Finally, left-click 
on OK in the third dialog box. 

4. Left-click on > in <Step> to display group #2. (Check the first line in the toolbox to 
make sure it shows #2.) 

5. Left-click on a hand, then left-click on < or> in <Pattern> until the hand you want 
appears. 
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6. Move the cursor onto the hand. Hold down the left mouse button and drag the hand to 
its new position. Move the cursor away and left-click to set the hand. 

Repeat steps 5 and 6 to move or replace the patterns in group #2 until the boy is in the 
second position for jumping jacks. 

Use the toolbox to delete mistakes or unwanted patterns: 

• To delete one pattern only from your group, left-click on the pattern. A flashing box 
appears around it. Next, left-click on Cel in the toolbox. In the dialog boxes that appear, 
left-click on Delete, then on OK. 

• To erase all edits and return to your original pattern, left-click on Undo in the toolbox. 

• To erase a group, left-click on Edit in the toolbox. In the dialog boxes that appear, left­
click on OK, then on Delete, then on OK. 

Animating Actors 

The next step in making your animated film is to define the boy doing jumping jacks as 
an actor. Actors have action steps called phases. The boy actor has two phases. Follow 
these steps: 

1. Display the Design menu and select Actors. The Actors toolbox and a blank animation 
board appear. 

2. Left-click on Phase in the toolbox. A dialog box appears. 

3. Left-click on Insert. Four new tools are added at the bottom of the toolbox. 

4. Left-click on< or> in <Group> until the first boy group appears. This creates the first 
phase. 

5. Left-click on the center of <Ph 1>, then on Insert in the dialog box that appears. 

6. Left-click on > in <Group> until the second boy group appears. This creates the second 
phase. 

7. Left-click anywhere on the animation board to animate the groups. 

Now define the series of stars you created as another actor. Follow the steps: 

1. Left-click on <Edit> in the toolbox. In the dialog boxes that appear, left-click on OK, 
then on Insert, then on OK. 

2. Left-click on Phase in the toolbox and on Insert in the dialog box that appears . 

3. Left-click on < or > in <Polygon> until the smallest star appears. 
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4. Left-click on the center of <Ph 1>, then on Insert in the dialog box. 

5. Left-click on> in <Polygon> until the next larger star appears. 

6. Repeat steps 4 and 5 with all the stars in order, until you create six phases with the six 
stars. 

Laying Out Stages 

Now's the time to create a stage for the actors in your animated film. Do this by laying 
out a forest of trees. Follow the steps: 

1. Display the Design menu and left-click on Stages. The Stages toolbox and a blank 
animation board appear. 

2. Left-click on Bkgnd Color in the toolbox. A selection box appears. 

3. Left-click on a green color box, then on OK. The animation board fills with back­
ground color. 

4. Next, add sky. Left-click on Cel in the toolbox. A dialog box appears. 

5. Left-click on Insert in the dialog box. 

6. Left-click on< or> in <Pattern> until the sky-blue rectangle appears. 

7. Hold down the left mouse button and drag the pattern to the top of the screen. Release 
the mouse button and left-click to set the sky in place. 
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Add trees to create a forested stage. Repeat steps 4 through 7 (left-clicking on < or > in 
<Group> in step 6 until the tree appears). Each time you repeat the steps, you'll add a 
tree. 

When you're finished, you'll have created stage #1. 

Creating Frames 

You've now designed all the film elements and you're ready to insert them into frames. 
Follow the steps: 

1. Right-click to display the menu bar. 

2. Display the Design menu and left-click on Editor. In the menu bar, the word "Design" 
changes to the word "Edit." 

3. Display the Edit menu and left-click on Frames. The frames toolbox and a blank 
animation board appear. 

4. Insert the stage. Left-click on< or> in <Stage> until stage #1 appears. 

5. Insert an actor. Left-click on Cel in the toolbox and on Insert in the dialog box that 
appears. Five new tools are added at the bottom of the toolbox. 

6. Left-click on the < or> in <Actor> until actor #2 appears. 

7. Hold down the left mouse button and drag the actor to the left side of the animation 
board. Then release the mouse button. 

~ Tip: Do NOT left-click or you will deselect the actor. If that happens, left-click 
•• on the actor again to select it. (A flashing box appears around the actor.) 

8. Now you can use tools tb move the boy across the screen. Left-click on Edit in the 
toolbox. A dialog box appears. 

9. Press Esc to delete the cycle number, type 20, and left-click on OK. A second dialog 
'box appears. 
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10. Left-click on Path, then on OK in the next dialog box. 

11. Move the mouse to move the actor to the right side of the screen and left-click. Doing 
this sets the path. The frame counter should now read #4 1. 

To view the frames, left click on# in the toolbox. Then left-click on First in the dialog 
box. Finally, hold down the left mouse button on> in <Step>. 

Now add your star to the film. Follow the steps. 

1. Left-click on # in the toolbox. A dialog box appears. 
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2. Press Backspace twice to remove the frame number. Then type 41, the number of the 
frame where the star will first appear, and left-click on OK. 

3. Left-click on Cel in the toolbox, then left-click on Insert in the dialog box. 

4. Left-click on< or> in <Actor> until the star appears. The Record tool is added to the 
bottom of the toolbox. · 

5. Left-click five times on Record in the toolbox. Record places actors on individual 
frames, even on pre-existing frames in which some animation has already been 
defined. 

~ Tip: Each left-click on Record sets an actor phase on a frame and increases the 
•• frame and phase numbers by one. You should click as many times as there are 

frames in which you want the actor to appear. 

You've now finished your film. To see it, display the menu bar, move the arrow to 
Options, and select Show Film. Left-click on OK in the dialog box. Then settle back and 
watch your film. 

Saving Your Film 

Unless they have been saved to disk, your film and all its elements are lost when your 
computer is turned off or a power interruption occurs. It's a good idea to save your files 
frequently to avoid losing your work if your computer is accidentally shut down. 

Save your work to a formatted blank disk. If you need to, use the Format Disk option in 
the File menu to format a disk. For details on how this is done, see the Format Disk 
section in the Film Director Reference. 

To save your film, follow the steps: 

1. Insert a blank, formatted disk into your drive. 

2. Display the menu bar and make sure Edit is the third menu selection from the left. 
Then move the arrow to File and left-click on Save Film. The item selector appears. 
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3. Type the filename JUMPJ ACK.FLM. (Or type JUMPJ ACK. Film Director will 
automatically save the file as an .FLM file.) 

4. Left-click on OK. Your file is saved to disk. 

Congratulations! You've successfully completed your first animated film . As you become 
familiar with Film Director, you will be able to use its advanced features to create 
increasingly complex animated films. These advanced features as well as Film Director's 
basic tools are fully described in the Film Director Reference section, next in this 
manual. 

,} 
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FILM DIRECTOR REFERENCE 
When you first load Film Director, its main screen appears. This is where you create and 
animate images with Film Director tools. 

Message -
Cursor 

- Coordinates (x,y) 

- Close Box and 
Toolbox Identifier 

- Toolbox 

Animation Board -

Message 
The message in the upper left comer suggests your next action and often gives informa­
tion about the current frame. The message changes as you perform operations on screen. 

When you first load Film Director, the message is Blank Object, indicating that the frame 
is empty. 

Cursor Coordinates (x,y) 
.} 

The cursor coordinates give the location of your cursor in pixels from the upper left 
comer of the Film Director animation board. They behave exactly the same way as the 
cursor coordinates in Art Director. 

Toolbox 
The toolbox contains many of the features you'll use to create your animated films. To 
hide a toolbox, left-click on its close box. Press FlO to return the toolbox to the screen. 
To move a toolbox, place the cursor on the toolbox identifier (which is also the move 
bar). Hold down the left mouse button and move the mouse left or right. The toolbox 
follows your mouse movements. Release the mouse button when the toolbox is where 
you want it. 
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When you first load Film Director, the default toolbox is the Frame toolbox. 

~ Tip: The tools in the toolbox change, depending on the options you select from 
•• the menu bar. Each particular toolbox is described in the section discussing the 

menu option it belongs to. The default toolbox (for the Frames option) is 
described in the section Frames later in this manual. 

Animation Board 
The animation board is where you create your films . It's equivalent to the canvas in Art 
Director. 

Film Director Menu Bar 
Right-click anywhere on the animation board to display the menu bar. The menu bar has 
four selections, each with its own menu of options you'll use when working with Film 
Director. 

Film Director ­
Menu Bar 
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Desk The Desk menu contains an option that displays the program credits and 
version number. 

File The File menu contains options for loading, saving, deleting, and printing 
pictures, scripts, and film files. It also provides options for saving the program 
preferences you set while using Film Director, formatting disks, and exiting the 
program. 

Edit Edit is the third selection in the default menu bar. The Edit menu provides 
options for inserting film elements into frames, adding special effects, and 
editing film sequences. When the Designer option is selected from the Edit 
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menu, then Design becomes the third menu bar selection. The Design menu 
contains options for designing film elements and using the palette in the toolbox. 

Options The Options menu includes options for controlling the on-screen 
components, erasing frames, scripts, and pictures, and previewing a film. 

Move the cursor across the menu bar. As the cursor touches each selection, the menu for 
that selection is displayed. Move the cursor down a menu to highlight its options. When 
an option is highlighted, you can left-click to select it. 

Left-click anywhere on the animation board to hide a menu. Left-click again to hide the 
menu bar. 

Desk Menu Option 
The Desk menu contains one option: About Film Director. 

...----rYF51t K' ,'II F Il E EDIT OPTIOIIS 
~out:~1 ft i..'Jlrect:O'lJil .. 

• 1 
< STEP > 

EDIT 
lHlO 

< ST& > 
Ptin[ A 
SG.Hl 

CEL 

When you select About Film Director, a dialog box displays the Film Director credits. 
Left-click on OK to return to the main screen. 

File Menu Options 
The File menu contains options for loading, saving, deleting, and printing pictures, 
scripts, and film files. It also provides an option for saving the program preferences you 
set while using Film Director, formatting disks, and exiting the program. 

The options in the menu change, depending on whether you're in Edit or Design mode. 
When you're in Edit mode, Edit is the third menu bar selection from the left. When you're 
in Design mode, Design is the the third selection. 
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File Menu 

in Edit Mode 

File Menu 

in Design Mode 

load Film 
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When you select Load Film, an item selector appears. The directory lists .FLM (film) 
files you can load onto the animation board. Use the item selector in the same way you 
use the Load Pict item selector in Art Director, but show the extension .FLM in the 
pathname. When you left-click on OK, your film is loaded onto the animation board. 
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Save Film 

When you select Save Film, an item selector appears. Here you can type in new file­
names for films just created, or save previously created films that you've edited. Use the 
item selector in the same way you use the Save Pict item selector in Art Director. When 
you left-click on OK, your film is saved to disk. 

Load Music 

When you select Load Music, its item selector appears. The directory lists .MUS (music) 
files you can load in order to add sound effects to your films. Use the item selector in the 
same way you use the Load Pict item selector in Art Director, but show the extension 
.MUS in the pathname. When you left-click on OK, your .MUS file is loaded. 

For complete details on adding sound to your films, see the Sound information in the 
Frames section later in this manual. 

Set Printer 

The Set Printer option lets you select the length of your printed line, in order to print Film 
Director screens. Use the Set Printer option in the same way you use Set Printer in Art 
Director. 

Print Screen 

Select the Print Screen option to print the current Film Director screen of patterns, 
polygons, groups, actors, frames, or sequences. Use this option in the same way you use 
Print Pict in Art Director. 

Save Screen 

The Save Screen option saves the current Film Director screen of patterns, polygons, 
groups, actors, frames, or sequences. When you select the option, an item selector 
appears. Use it in the same way you use the Save Pict item selector in Art Director. The 
current screen will be saved as an .ART file. 

Save Prefs 

The settings you selected with the Select Cursor and Display Tools options in the Options 
menu, and the Set Printer option in the File menu, are saved to disk when you select Save 
Prefs. Use this option in the same way you use the Save Prefs option in Art Director. The 
settings are saved to a file named F.PRE. 
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~ Tip: Make sure the disk containing the Film Director program FILMDIR.PRG 
•• is in your working drive before you select Save Prefs. 

Delete File 

The Delete File option lets you erase a file from disk. When you select this option, an 
item selector appears. Use it in the same way you use the Delete File item selector in Art 
Director. When you left-click on OK, the file will be deleted from disk. 

~ Tip: Be certain you want to delete the file before selecting OK. Once a file is 
•• deleted, it cannot be recovered. 

Format Disk 

The Format Disk option lets you format a data disk from within the Film Director 
program. Use this option in the same way you use Format Disk in Art Director. 

Quit 

Select Quit to exit the Film Director program. Use this option in the same way you use 
Quit in Art Director. 

Load Script 

Select the Load Script option to load an .SCR (script) file. An .SCR file contains all the 
patterns, polygons, groups, actors, and stages used in a film . 

When you select Load Script, an item selector appears. Use it in the same way you use 
the Load Pict item selector in Art Director, but show the extension .SCR in the path name. 
When you left-click on OK, the file is loaded into Film Director. 

Load Picture 

Select the Load Picture option to load an .ART file. An .ART file contains a canvas of 
images from Art Director that you can cut out as patterns for a film . 

When you select Load Picture, a selection box appears listing all available picture 
locations in Film Director. Left-click on the location you want to load the picture file to. 
Then left-click on OK. 

An item selector appears. To load your picture, use the item selector in the same way you 
use the Load Pict item selector in Art Director. When you left-click on OK, the .ART file 
will be loaded onto the animation board. 
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ii Tip: The palettes used in your film will be the palettes of picture A. 

Save Script 

Select the Save Script option when you want to save a script file. An item selector 
appears. Use it in the same way you use the Save Pict item selector in Art Director. When 
you left-click on OK, the file will be saved as an .SCR file. 

Save Picture 

Select the Save Picture option to save your animation board as an .ART file. A selection 
box appears listing all available picture locations in Film Director. Left-click on the 
location of the picture you want to save. Then left-click on OK. 

An item selector appears. To save your picture, use the item selector in the same way you 
use the Save Pict item selector in Art Director. When you left-click on OK, the picture 
will be saved as an .ART file. 

Edit Menu Options 
The Edit menu provides options for inserting film elements into frames, adding special 
effects, and editing film sequences. 

Frames 

The Frames option lets you create and edit the frames of an animated film. When you 
select this option, its toolbox appears along with the first frame. Use the Frames tools to 
add predefined patterns, polygons, groups, actors, stages, and sounds to individual 
frames. 
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- Frame Counter 

Frame Counter Shows the number of the frame currently on screen. Left-click 
on the counter and the frame selection box appears. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the frame you want to see. When you left-click on OK, the 
frame appears. 

• Left-click on either First or Last to see the first or last frame in a series. 

• Left-click on Mark 1 or Mark 2 to see either the first or last marked frame in a 
sequence. (Frames are marked with the Mark tool in the Sequence toolbox.) 

• When you have more than one frame, a box appears in the slide bar. Drag the 
box right or left to change the frame number in the selection box. Left-click on 
either arrow to increase or decrease the frame number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected frame appears. 

<Step> Displays the next frame in a series. Left-click on< or> to display the 
next frame backward or forward. Hold down the left mouse button on < or > to 
scan the entire series backward or forward. 

Edit Inserts, deletes, and duplicates frames. When you left-click on Edit, a 
dialog box appears asking for the number of cycles. (For Insert and Delete, the 
number of cycles will be the number of frames you want to affect. For Copy and 
Append, it is the number of times one frame is duplicated. For Tween, it is the 
number of frames inserted between two selected frames.) 
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• Press Backspace or Esc to erase the number in the box, then type in the 

number of cycles. Or left-click on Single for only one cycle. When you left­
click on OK, a selection box appears. 

• Select Insert to add the selected number of blank frames, then select OK in the 
dialog box that appears. The frames are added before the current frame and all 
following frames are renumbered. 

• Select Delete to erase the selected number of frames, then select OK in the 
dialog box that appears. The frames are erased, beginning with the current 
frame, and all following frames are renumbered. 

• Select Copy to duplicate the current frame the selected number of times, then 
select OK in the dialog box that appears. The duplicate frames are added after 
the current frame and all subsequent frames are renumbered. 

• Select Append to duplicate the current frame the selected number of times and 
add those new frames to the end of the series. Select OK in the dialog box that 
appears to complete the operation. 

• Select Tween to generate the selected number of frames between the current 
frame and the frame preceding it. Left-click on OK in the dialog box that 
appears. The frames are generated and all subsequent frames are renumbered. 

Undo Cancels all actions taken from the toolbox for the current frame. Left­
click on Undo (or press the Undo key). 

<Stage> Places a predefined stage behind all foreground elements on your 
frame. Left-click on < or> to see the next stage backward or forward. Hold 
down the left mouse button on< or> to scan the entire series of stages back­
ward or forward. 

When you left-click on the center of <Stage>, its selection box appears. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the stage you want to see. When you left-click on OK, the 
frame appears. 

• Left-click on either First or Last to see the first or last stage in a series. 

• When you have more than one stage, a box appears in the slide bar. Drag the 
box right or left to change the stage number. Left-click on either arrow to 
increase or decrease the stage number by one. Left-click on the gray area on 
either side of the box to increase or decrease the number by ten. When you 
left-click on OK, the selected stage appears. 
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Palette Shows the palette currently selected for your frame. Left-click on 
Palette to see a selection box offering eight palette selections lettered A through 
H. Left-click on a letter to select that palette, then left-click on OK. The new 
palette letter appears in the toolbox. 

The colors in the current palette appear below the lettered boxes in the palette 
selection box. These colors can be modified with the Palette option in the 
Design menu. For details on modifying colors, see Palette later in this manual. 

Sound Use this tool to add sound effects to the current frame. Left-click on 
Sound to see its selection box offering nine sound selections numbered 1 
through 9. Left-click on a number to select that sound. 

• Left-click on Play to preview the sound. 

• Select Off to shorten a sound. Use this to prevent sounds from continuing 
longer than the corresponding action in your film . 

• Select None if you want no sound in your frame. 

Make your selection and left-click on OK. The number of the sound appears in 
the toolbox. 

Cel Lets you add or delete patterns, polygons, groups, or actors from your film. 
Each element is added as a layer, or eel, to the current frame. 

When you left-click on Cel, its selection box appears. When you select Insert 
from the selection box, tools are added to the toolbox for these five items: 
layers, patterns, polygons, groups, and actors. 

Patterns, polygons, groups, and actors are created with options from the Design 
menu. (See Design Menu Options later in this manual for full details.) To 
generally describe them, they are the animated images in your film. They are 
placed onto a frame in layers, with one pattern, polygon, group, or actor in each 
layer. To change an image's layering, left-click on it. Then left-click on the up or 
down arrow in the Layer tool to place the image in front of or behind an image it 
overlaps. 

~ 
•• Tip: You cannot place a eel behind a stage. 
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Left-click on <Pattern>, <Polygon>, <Group>, or <Actor> to see its selection 
box. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the element you want to see. When you left-click on OK, that 
element appears. 

• Left-click on either First or Last to see the first or last element in the series. 
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• When you have more than one element available, a box appears in the slide 
bar. Drag the box right or left to change the element number showing in the 
selection box. Left-click on either arrow to increase or decrease the element 
number by one. Left-click on the gray area on either side of the box to increase 
or decrease the number by ten. When you left-click on OK, the selected 
element appears. 

Move the cursor to the element, hold down the left mouse button, and drag the 
element to where you want it in the frame. Release the mouse button .to set the 
element in place. 

When you select <Actor>, another tool, Record, is added to the toolbox and the 
first phase of your actor appears. Position the phase where you want it, then left­
click on Record to set the phase in place. Your frame advances by one and the 
next phase of the actor appears. Continue positioning and recording your actor 
phases on the frames for as long as you want. If you record on all pre-existing 
frames, new frames will be generated as you continue recording. 

If you want your actor to perform while moving in a straight line, without your · 
having to place each phase, you can use Path. Left-click on Cel, then left-click 
on Insert. Left click on either< or > of <Actor> until the actor you want 
appears. Move the cursor to the actor, hold down the left mouse button, and drag 
the actor to where you want its path to start. Release the mouse button (but do 
not left-click). Left-click on Edit in the toolbox. Type in the number of times 
you want your actor to cycle through its phases and left-click on OK. Left-click 
on Path, then on OK from the dialog boxes that appear. The message now says 
"Define end of path." 

Move the actor to the end of the path and left-click. Film Director creates the 
appropriate number of frames necessary for your actor to perform along the path 
you defined. For every cycle requested, Film Director creates a number of 
frames equal to the number of phases in your actor. 

·• To delete an element from a frame, first left-click on it on the animation board. 
Then select Cel from the toolbox and Delete from the selection box that appears. 
Finally, left-click on OK in the warning box. The element is erased from your 
frame. 

Sequence 

The Sequence option lets you edit, view, or add special effects to a series of frames. 
When you select Sequence from the Edit menu, its toolbox appears. 
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- Frame Counter 

Frame Counter Your sequence contains a number of frames . The frame 
counter shows the number of the frame currently on screen. Left-click on the 
counter and the frame selection box appears. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the frame you want to see. When you left-click on OK, the 
frame appears. 

• Left-click on either First or Last to see the first or last frame in a series. 

• Left-click on Mark 1 or Mark 2 to see either the first or last marked frame in a 
sequence. (Frames are marked with the Mark tool in the toolbox.) 

• When you have more than one frame, a box appears in the slide bar. Drag the 
box right or left to change the frame number in the selection box. Left-click on 
either arrow to increase or decrease the frame number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected frame appears. 

<Step> Displays the next frame. Left-click on < or > to see the next frame 
backward or forward. Hold down the left mouse button on < or > to scan the 
entire series backward or forward. 

Edit Deletes, copies, or appends a sequence in your film. The sequence to be 
affected is determined by the frames in the sequence you've marked as 1 and 2. 

• Select Delete to erase the frames marked 1 and 2 and all frames between them. 
Left-click on OK in the warning box to complete the operation. 



Mi@lm&Qd 
• Select Copy to duplicate the frames marked 1 and 2 and all frames between 

them. Select OK from the dialog box that appears to complete the operation. 
The frames will be copied in sequence and inserted before your current frame. 

• Select Append to add the frames marked 1 and 2 and all frames between them 
to the end of your film. Select OK in the dialog box to complete the operation. 

Mark Use this tool to mark the frame currently on screen as either the begin­
ning frame (1) or the ending frame (2) of your sequence. When the frame you 
want to mark is on screen, left-click on either 1 or 2 to mark it. When two 
frames have been marked as 1 and 2, those frames and all frames between them 
become a marked sequence. 

Stage Selects a stage to be added to all the frames in a sequence. The beginning 
and ending frames of the sequence are defined by mark 1 and mark 2. When you 
left-click on Stage, its selection box appears. 

• Press Backspace or Esc to erase the number in the box, then type in the 
number of the stage you want to see. When you left-click on OK, that stage is 
placed in all frames of your sequence. 

• Left-click on either First or Last to see the first or last stage in a series. The 
selected stage appears and is placed in all frames of your sequence. 

• When you have more than one stage, a box appears in the slide bar. Drag the 
box right or left to change the stage number in the selection box. Left-click on 
either arrow to increase or decrease the stage number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected stage appears and is placed in all 
frames of your sequence. ' 

Palette Shows the palette currently selected for your sequence. Left-click on 
Palette to see a selection box offering eight palette selections lettered A through 
H. Left-click on a letter to select that palette, then left-click on OK/ The new. 
palette letter appears in the toolbox. 

The colors in the current palette appear below the lettered boxes in the palette 
selection box. These colors can be modified with the Palette option in the 
Design menu. For details on modifying colors, see Palette later in this manual. 

View Previews the sequence of frames defined by mark 1 and mark 2. Left­
click on View to see its selection box. The number in the selection box is your 
current film speed. Speeds range from 1 to 25. Left-click on Slower or Faster to 
change the speed. Lower numbers slow down the film; higher numbers speed it 
up. Then left-click on OK to preview your sequence. 

~ Tip: If the frame marked 1 has a higher sequence number than the frame marked 
•• 2, your sequence will run in reverse when you view it. 
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Cel Lets you manipulate the elements on the layers you added to your frames 
with the Cel tool in the Frames toolbox. Select Cel to see its sele€tion box. 

• Interpolate Lets you create intermediate images on the top layer of a 
sequence. First, use the Frames toolbox to place beginning and ending 
versions of a pattern, polygon, or group onto two different frames. Return to 
the toolbox and use the Mark tool to mark the frames as 1 and 2. Finally, 
select Cel and left-click on Interpolate in the selection box, then on OK in the 
dialog box that appears. Interpolate will generate intermediate images on the 
frames between the marked frames. When you view your sequence, the 
element you interpolated will appear to move or change. 

• Overlay Copies all patterns, polygons, and groups in a sequence, then 
adds the copies to the film, beginning with the current frame. Select Overlay, 
then left-click on OK in the dialog box that appears. In your frame, move the 
mouse to position the elements, and left click to set the overlay in place. 

When you view the film, the copied elements appear, performing the same 
motion as their originals. 

• Peel Erases the topmost element from a sequence. Select Peel, then left-click 
on OK in the dialog box that appears. Elements copied to your film with 
Interpolate and Overlay can be erased with Peel. 

• Trace On Creates a trail of after-images of actors as they "move" through a 
marked sequence. Select Trace On, then left-click on OK in the dialog box that 
appears. 

~ Tip: If your stage changes while you are viewing or showing a film, any after­
•• images are erased. 

• Trace Off Turns off the Trace On operation in a marked sequence. Select 
Trace Off, the left-click on OK in the dialog box that appears. 

Designer 

Selecting Designer puts you in Design mode, with Design as the third menu bar selection 
from the left. For complete information, see the next section, Design Menu Options. 

Design Menu Options 
The Design menu contains options for designing film elements. 
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Patterns 

The Patterns option lets you create patterns to use in your films. When you select this 
option, its toolbox appears. Use the Patterns tools to create, edit, and cut out patterns 
from .ART pictures you have loaded into memory with the Load Picture option in the 
File menu. 
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Pattern Counter Shows the number of the pattern currently on screen. Left­
click on the counter and the pattern selection box appears. 
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• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the pattern you want to see. When you left-click.on OK, that 
pattern appears. 

• Left-click on either First or Last to see the first or last pattern in a series. 

• When you have more than one pattern, a box appears in the slide bar. Drag the 
box right or left to change the pattern number in the selection box. Left-click 
on either arrow to increase or decrease the pattern number by one. Left-click 
on the gray area on either side of the box to increase or decrease the number 
by ten. When you left-click on OK, the selected pattern appears. 

<Step> Displays the next pattern in a series. Left-click on< or> to display the 
next pattern backward or forward. Hold down the left mouse button on < or > to 
scan the entire series backward or forward. 

Rearrange Inserts, deletes, and rearranges the order of patterns. Left-click on 
rearrange to see its selection box. 

• Select Insert to add a blank pattern in the current position. Then left-click on 
OK in the dialog box that appears. The blank pattern is inserted and all follow­
ing patterns are renumbered. 

• Select Delete to erase the current pattern. Then left-click on the dialog box 
that appears. The pattern is erased and all following patterns are renumbered. 

• Select Send to move the current pattern to the end of the pattern series. Then 
left-click on OK in the dialog box that appears. The pattern is moved and all 
following patterns are renumbered. 

• Select Get to bring the last pattern in the series into the current position. Then 
left-click on OK in the dialog box that appears. The last pattern appears in the 
current position and the current pattern is deleted. 

Undo Usually cancels your last action taken from the toolbox. Left-click on 
Undo (or press the Undo key). A pattern that has been cut out or rearranged 
cannot be undone. 

Draw Lets you draw a new picture or edit an existing picture. When you left­
click on Draw, the toolbox gives you a color swatch and Zoom tool. 

Move the cursor onto a color in the palette and left-click to select it. That color 
appears in the color swatch. Then move the cursor (a pencil) onto the animation 
board. Hold down the left mouse button while moving the mouse to draw in the 
color you selected. You can draw over existing pictures or create new pictures. 
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Left-click on Zoom in the toolbox to magnify an area for detailed drawing. The 
cursor becomes a flashing box. Move it onto the animation board, positioning it 
over the area you want to magnify. Then left-click to display the magnified area. 
Move the cursor (a small flashing box) over the area and left-click to add a 
single pixel of color at the cursor position. 

To exit from the Zoom and Draw tools, left-click on Exit in the toolbox. 

Cut Cuts out a pattern. Select Cut, then move the cursor (flashing crosshairs) 
onto the animation board. Position the bars of the cursor over the top and to the 
left of the pattern you want to cut. Left-click, then move the mouse down and to 
the right. A flashing box follows the cursor. When the box encloses the pattern, 
left-click to cut out the pattern. The pattern is added at the end of your pattern 
series (and the number in the counter is increased by one). 

Picture Lets you select a picture to display on the animation board. Left-click 
on the tool. A selection box appears listing picture pages. Left-click on the page 
you want, then left-click on OK. The picture appears on screen and the letter of 
that picture is listed in the toolbox. If there is no picture currently on the page 
you select, a blank animation board appears. 

~ Tip: In systems having only 512K of memory, only two pages, A and B, are 
•• available. Left-click on Picture to toggle between pages. 

Palette Shows the 16 colors available for use in your current picture. Left-click 
on a color in the palette to fill the screen with that color. Then use Cut to cut out 
a rectangle. Left-click on Picture in the toolbox to return to your current picture. 

When using the Draw tool, left-click on a color in the palette to select it for 
drawing. 

~ Tip: To change the colors in your palette, use the Palettes option in the Design 
•• menu. For complete instructions, see the Palettes section later in this manual. 

,;11 , 

Polygons 

The Polygons option lets you draw, color, and edit line-drawings to use in your films. 
When you select this option, the Polygon toolbox appears. 
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- Polygon Counter 

Move the cursor onto the animation board and left-click to set the first point of your 
polygon. Then move the mouse to draw a line. Left-click to set the second point of the 
polygon. Continue moving the mouse and left-clicking to set all subsequent points of 
your design. When the polygon is finished, double-left-click. The palette and Clip tools 
are added to the toolbox. 
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Polygon Counter Shows the number of the polygon currently on screen. Left­
click on the counter and the polygon selection box appears. 

• Press Backspace or Esc to erase the number in the selection box. Then type in 
the number of the polygon you want to see. When you left-click on OK, that 
polygon appears. 

• Left-click on either First or Last to see the first or last polygon in a series. 

• When you have more than one polygon in your series, a box appears in the 
slide bar. Drag the box right or left to change the polygon number in the 
selection box. Left-click on either arrow to increase or decrease the polygon 
number by one. Left-click on the gray area on either side. of the box to increase 
or decrease the number by ten. When you left-click on OK, the selected 
polygon appears. 

<Step> Displays the next polygon in a series. Left-click on < or > to display the 
next polygon backward or forward. Hold down the left mouse button on < or > 
to scan the entire series backward or forward. 

Edit Inserts, deletes, and duplicates polygons, and generates intermediate 
polygons between two existing polygons. 
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When you left-click on Edit, a dialog box appears asking for the number of 
cycles. (For Insert and Delete, the number of cycles will be the number of 
polygons you want to affect. For Copy and Append, it is the number of times 
one polygon is duplicated. For Tween, it is the number of intermediate polygons 
inserted between two selected polygons.) Press Backspace or Esc to erase the 
number in the box, then type in the number of cycles. Or left-click on Single for 
only one cycle. When you left-click on OK, a selection box appears. 

o Select Insert to add the selected number of blank polygons, then select OK in 
the dialog box that appears. The polygons are inserted before the current 
polygon and all following polygons are renumbered. 

o Select Delete to erase the selected number of polygons, then select OK in the 
dialog box that appears. The polygons are erased, beginning with the current 
polygon, and all following polygons are renumbered. 

o Select Copy to duplicate the current polygon the selected number of times, 
then select OK in the dialog box that appears. The duplicate polygons are 
added after the current polygon and all following polygons are renumbered. 

o Select Append to duplicate the current polygon the selected number of times 
and add those new polygons to the end of the series. Select OK in the dialog 
box that appears to complete the operation. 

o Select Tween to generate the selected number of intermediate polygons 
between the current polygon and the polygon preceding it. Left-click on OK in 
the dialog box that appears. The polygons are generated and all following 
polygons are renumbered. 

When the selected polygons are different sizes or shapes, Tween generates a 
series of "changing" polygons. When the series is viewed as a sequence, the 
polygon appears to grow or change. 

_.I 

When the selected polygons are identical but in different positions, Tween 
generates a series of repositioned polygons. When the series is viewed as a 
sequence, the polygon appears to move. 

Undo Cancels all actions taken from the toolbox for the current polygon. Left­
click on Undo (or press the Undo key). 

<Stage> Lets you preview an existing stage with your current polygon, in order 
to align the polygon correctly for use on that stage later when you set up your 
frames . Left-click on the tool to see its selection box. 

o Press Backspace or Esc to erase the number in the box, then type in the 
number of the stage you want to see. When you left-click on OK, that stage 
appears on your animation board, behind the polygon. 

117 



o Left-click on either First or Last to see the first or last stage in a series. The 
selected stage appears behind the current polygon. 

o When you have more than one stage, a box appears in the slide bar. Drag the 
box right or left to charige the stage number in the selection box. Left-click on 
either arrow to increase or decrease the stage number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected stage appears behind the current 
polygon. 

With a stage displayed, you can preview how your polygon looks on it. Move 
the cursor onto the animation board. Hold down the left mouse button. The 
cursor changes to a flat hand. Now move the mouse to move your polygon onto 
the stage. When the polygon is positioned correctly, release the mouse button. 

If you position the cursor on a side or angle of your polygon and hold down the 
left mouse button, the cursor changes to a hand pinching the polygon. Move the 
mouse to drag the side or angle to a new position, then release the mouse button. r. Tip: When you drag a side, you create a new angle. 

Palette Shows the 16 colors available for coloring your polygons. Left-click on 
a color in the palette to select it. Then move the cursor onto a line in your 
polygon and left-click to color the line from angle to angle. 

~ Tip: To change the colors in your palette, use the Palettes option in the Design 
•• menu. For complete instructions, see the Palettes section later in this manual. 

Clip Deletes an angle of a polygon. Select Clip, then move the cursor (a 
clipper) onto the polygon angle you want to clip. Left-click to delete the angle. 
The polygon reforms with one less angle. 

Groups 

The Groups option lets you create groups to use in your films. Groups are collections of 
patterns and polygons. When you select this option, its toolbox appears. 
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- Group Counter 

Group Counter Shows the number of the group currently on screen. Left-click 
on the counter and the group selection box appears. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the group you want to see. When you left-click on OK, that 
group appears. 

• Left-click on either First or Last to see the first or last group in a series. 

• When you have more than one group, a box appears in the slide bar. Drag the 
box right or left to change the group number in the selection box. Left-click on 
either arrow to increase or decrease the group number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected group appears. ·' : 

<Step> Displays the next group in a series. Left-click on < or > to display the 
next group backward or forward. Hold down the left mouse button on < or > to 
scan the entire series backward or forward. 

Edit Inserts, deletes, and duplicates groups, and generates intermediate groups 
between two existing groups. 

When you left-click on Edit, a dialog box appears asking for the number of 
cycles. (For Insert and Delete, the number of cycles will be the number of 
groups you want to affect. For Copy and Append, it is the number of times one 
group is duplicated. For Tween, it is the number of intermediate groups inserted 
between two selected groups.) Press Backspace or Esc to erase the number in 
the box, then type in the number of cycles. Or left-click on Single for only one 
cycle. When you left-click on OK, a selection box appears. 
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• Select Insert to add the selected number of blank groups, then select OK in the 
dialog box that appears. The groups are inserted before the current group and 
all following groups are renumbered. 

• Select Delete to erase the selected number of groups, then select OK in the 
dialog box that appears. The groups are emsed, beginning with the current 
group, and all following groups are renumbered. 

• Select Copy to duplicate the current group the selected number of times. Then 
select OK in the dialog box that appears. The duplicate groups are added after 
the current group and all following groups are renumbered. 

• Select Append to duplicate the current group the selected number of times and 
add those new groups to the end of the series. Select OK in the dialog box that 
appears to complete the operation. 

• Select Tween to generate the selected number of intermediate groups between 
the current group and the group preceding it. Left-click on OK in the dialog 
box that appears. The groups are generated and all following groups are 
renumbered. 

When the patterns and polygons in the selected groups are in different 
positions, Tween generates a series of "changing" groups. When the series is 
viewed as a sequence, the groups appear to move. 

Undo Cancels all actions taken from the toolbox for the current group. Left­
click on Undo (or press the Undo key). 

<Stage> Lets you preview an existing stage with your current group, in order to 
position the group correctly for use on that stage later when you set up your 
frames. Left-click on the tool to see its selection box. 

• Press Backspace or Esc to erase the number in the box, then type in the 
number of the stage you want to see. When you left-click on OK, that stage 
appears on your animation board, behind the group. 

• Left-click on either First or Last to see the first or last stage in a series. The 
selected stage appears behind the current group. 

• When you have more than one stage, a box appears in the slide bar. Drag the 
box right or left to change the stage number in the selection box. Left-click on 
either arrow to increase or decrease the stage number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected stage appears behind the current 
group. 

With a stage displayed, you can preview how your group looks on it. Move the 
cursor onto the animation board. Hold down the left mouse button. The cursor 
changes to a flat hand. Now move the mouse to move your group on the stage. 
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When the group is positioned correctly, release the mouse button. 

If you position the cursor on a single element in the group and hold down the 
left mouse button, the cursor changes to a hand pinching the element. Move the 
mouse to drag the element to a new position, then release the mouse button. A 
flashing box appears around the element. You can move the element again, or, if 
it is positioned where you want it, left-click to set it in that position. 

Cel Lets you add or delete patterns and polygons from your group. Each 
element is added as a layer, or eel, to the current group. 

When you left-click on Cel, its selection box appears. When you select Insert 
from the selection box, tools are added to the toolbox for these three items: 
layers, patterns, and polygons. 

Patterns and polygons can be placed onto your group in layers, with one element 
per layer. To change an image's layering, left-click on it. Then left-click on the 
up or down arrow in the Layer tool to place the image in front of or behind an 
image it overlaps. 

Left-click on <Pattern> or <Polygon> to see its selection box. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the element you want to see. When you left-click on OK, that 
element appears. 

• Left-click on either First or Last to see the first or last element in the series. 

• When you have more than one element available, a box appears in the slide 
bar. Drag the box right or left to change the element number showing in the 
selection box. Left-click on either arrow to increase or decrease the element 
number by one. Left-click on the gray area on either side of the box to increase 
or decrease the number by ten. When you left-click on OK, the setected 
element appears. " 

Move the cursor to the element, hold down the left mouse button, and drag the 
element to where you want it in the group. Release the mouse button, move the 
cursor away from the element, then left-click to set it in place. 

To delete an element from a frame, first left-click on it on the animation board. 
Then select Cel from the toolbox and Delete from the selection box that appears. 
Finally, left-click on OK in the warning box. The element is erased from your 
frame. 
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Actors 
The Actors option lets you arrange patterns, polygons, and groups into animated images 
called actors. When you select Actors from the Design menu, its toolbox appears. 

122 

- Actor Counter 

Actor Counter Shows the number of the actor currently on screen. Left-click 
on the counter and the actor selection box appears. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the actor you want to see. When you left-click on OK, that actor 
appears. 

• Left-click on either First or Last to see the first or last actor in a series. 

• When you have more than one actor, a box appears in the slide bar. Drag the 
box right or left to change the actor number in the selection box. Left-click on 
either arrow to increase or decrease the actor number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected actor appears. 

<Step> Displays the next actor in a series. Left-click on < or > to display the 
next actor backward or forward. Hold down the left mouse button on < or > to 
scan the entire series backward or forward. 

Edit Inserts, deletes, and duplicates actors. 
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When you left-click on Edit, a dialog box appears asking for the number of 
cycles. (For Insert and Delete, the number of cycles will be the number of actors 
you want to affect. For Copy and Append, it is the number of times one actor is 
duplicated. For Tween, it is the number of intermediate phases inserted between 
the selected phase and the one preceding it.) Press Backspace or Esc to erase 
the number in the box, then type in the number of cycles. Or left-click on Single 
for only one cycle. When you left-click on OK, a selection box appears. 

o Select Insert to add the selected number of blank actors, then select OK in the 
dialog box that appears. The actors are inserted before the current actor and all 
following actors are renumbered. 

o Select Delete to erase the selected number of actors, then select OK in the 
dialog box that appears. The actors are erased, beginning with the current 
actor, and all following actors are renumbered. 

o Select Copy to duplicate the current actor the selected number of times. Then 
select OK in the dialog box that appears. The duplicate actors are added after 
the current actor and all following actors are renumbered. 

o Select Append to duplicate the current actor the selected number of times and 
add those new actors to the end of the series. Select OK in the dialog box that 
appears to complete the operation. 

o Select Tween to generate the selected number of intermediate phases between 
the current phase and the phase preceding it. Left-click on OK in the dialog 
box that appears. The phases are generated and all following phases are 
renumbered. 

Undo Cancels all actions taken from the toolbox for the current actor. Left-click 
on Undo (or press the Undo key). 

<Stage> Lets you preview an existing stage with your current actor:,.. in order, to 
position the actor correctly for use on that stage later when you set up your · 
frames. Left-click on the tool to see its selection box. 

o Press Backspace or Esc to erase the number in the box, then type in the 
number of the stage you want to see. When you left-click on OK, that stage 
appears on your animation board, behind the actor. 

o Left-click on either First or Last to see the first or last stage in a series. The 
selected stage appears behind the current actor. 

o When you have more than one stage, a box appears in the slide bar. Drag the 
box right or left to change the stage number in the selection box. Left-click on 
either arrow to increase or decrease the stage number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 
When you left-click on OK, the selected stage appears behind the current 
actor. 
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With a stage displayed, you can preview how your actor looks on it. Move the 
cursor onto the animation board. Hold down the left mouse button. The cursor 
changes to a flat hand. Now move the mouse to move your actor on the stage. 
When the actor is positioned correctly, release the mouse button. The actor 
cycles through all its phases as you do this. 

<Phase> Displays, inserts, or deletes an actor's phases. A phase is an individual 
action step. An actor is made up of two or more phases. Left-click on <or> in 
the tool to stop an actor at either the first or last phase. The number of the phase 
appears in the toolbox. Hold down the left mouse button on < or > to scroll 
backward or forward through the actor's phases. 

When you select Phase, four tools are added to the Actor toolbox for these 
items: order, patterns, polygons, and groups. 

The <Order> tool changes the order of two phases. Left-click on< to swap the 
current phase with the one that precedes it. Left-click on> to swap the current 
phase with the one that follows it. 

When you left-click on the center of the phase tool, its selection box appears. 
Left-click on Insert to add a pattern, polygon, or group to the current phase. 
(You can only have one eel per phase.) Then left-click on <Pattern>, <Poly­
gon>, or <Group> in the toolbox to see a selection box. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the element you want to see. When you left-click on OK, that 
element appears. 

• Left-click on either First or Last to see the first or last element in the series. 

• When you have more than one element available, a box appears in the slide 
bar. Drag the box right or left to change the element number showing in the 
selection box. Left-click on either arrow to increase or decrease the element 
number by one. Left-click on the gray area on either side of the box to increase 
or decrease the number by ten. When you left-click on OK, the selected 
element appears. 

Move the cursor to the element, hold down the left mouse button, and drag the 
element to where you want it in the phase. Release the mouse button, move the 
cursor away from the element, then left-click to set it in place. When you view 
the actor, that element appears in the selected phase. 

To delete a phase, first display it by selecting< or> in the phase tool. Then left­
click on the center of the phase tool. Select Delete from the dialog box, and left­
click on OK in the second dialog box that appears. The phase is deleted from 
your actor. 



M«lhifmn;g 

Stages 

The Stages option lets you establish a stage or background for your animated film. After 
you create a stage, you can place it into a frame by using the Frames and Sequences 
options in the Edit menu. When you select Stages from the Design menu, its toolbox 
appears. 

- Stage Counter 

Stage Counter Shows the number of the stage currently on screen. Left-click 
on the counter and the stage selection box appears. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the stage you want to see. When you left-click on OK, that stage 
appears. 

• Left-click on either First or Last to see the first or last stage in a series. 

• When you have more than one stage, a box appears in the slide bar. Drag the 
box right or left to change the stage number in the selection box. Left-click on 
either arrow to increase or decrease the stage number by one. Left-click on the 
gray area on either side of the box to increase or decrease the number by ten. 

When you left-click on OK, the selected stage appears. 

<Step> Displays the next stage in a series. Left-click on< or> to display the 
next stage backward or forward. Hold down the left mouse button on < or > to 
scan the entire series backward or forward . 

Edit Inserts, deletes, and duplicates stages, and generates intermediate stages 
between two existing stages. 
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When you left-click on Edit, a dialog box appears asking for the number of 
cycles. (For Insert and Delete, the number of cycles will be the number of stages 
you want to affect. For Copy and Append, it is the number of times one stage is 
duplicated. For Tween, it is the number of intermediate stages inserted between 
two selected stages.) Press Backspace or Esc to erase the number in the box, 
then type in the number of cycles. Or left-click on Single for only one cycle. 
When you left-click on OK, a selection box appears. 

• Select Insert to add the selected number of blank stages, then select OK in the 
dialog box that appears. The stages are inserted before the current stage and all 
following stages are renumbered. 

• Select Delete to erase the selected number of stages, then select OK in the 
dialog box that appears. The stages are erased, beginning with the current 
stage, and all following stages are renumbered. 

• Select Copy to duplicate the current stage the selected number of times. Then 
select OK in the dialog box that appears. The duplicate stages are added after 
the current stage, and all following stages are renumbered. 

• Select Append to duplicate the current stage the selected number of times and 
add those new stages to the end of the series. Select OK in the dialog box that 
appears to complete the operation. 

• Select Tween to generate the selected number of intermediate stages between 
the current stage and the stage preceding it. Left-click on OK in the dialog 
box that appears. The stages are generated and all following stages are 
renumbered. 

Undo Cancels all actions taken from the toolbox for the current stage. Left­
click on Undo (or press the Undo key). 

Text Lets you add text to your stage. When you left-click on Text, a flashing 
line appears in the lower left corner of the animation board. Use your Arrow 
keys to move the line to where you want text to begin. Then type your text. If 
you make a mistake, press Backspace to erase one character, or press Delete to 
erase all text. 

After finishing a line of text, move the flashing line again with your Arrow keys 
to add other lines. When you've typed all text, press Esc to complete the 
operation. 

Bkgnd Color Lets you change the background color of your stage. When you 
left-click on the tool, its selection box appears, offering the 16 color choices 
from your palette. Left-click on the color you want, then left-click on OK. The 
background color in your stage will change to the color you just selected. 
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Text Color Lets you choose the color of text added to your stage with the Text 
tool. When you left-click on Text Color, its selection box appears, offering the 
16 color choices from your palette. Left-click on the color you want, then left­
click on OK. The text in your stage (and any text you add later) appears in the 
newly chosen color. 

Cel Lets you add, delete, or modify patterns, polygons, and groups in your 
stage. Each element is added as a layer, or eel, to the current group. 

When you left-click on Cel, its selection box appears. When you select Insert 
from the selection box, tools are added to the toolbox for these four items: 
layers, patterns, polygons, and groups. 

Patterns, polygons, and groups can be placed onto your stage in layers, with one 
element per layer. To change an image's layering, left-click on it. Then left-click 
on the up or down arrow in the Layer tool to place the image in front of or 
behind an image it overlaps. 

Left-click on <Pattern>, <Polygon>, or <Group> to see its selection box. 

• Press Backspace or Esc to erase the number in the selection box, then type in 
the number of the element you want to see. When you left-click on OK, that 
element appears. 

• Left-click on. either First or Last to see the first or last element in the series. 

• When you have more than one element available, a box appears in the slide 
bar. Drag the box right or left to change the element number showing in the 
selection box. Left-click on either arrow to increase or decrease the element 
number by one. Left-click on the gray area on either side of the box to increase 
or decrease the number by ten. When you left-click on OK, the selected 
element appears. 

' . 
Move the cursor to the element, hold down the left mouse button, arid drag tlie 
element to where you want it on the stage. To modify your element, select Cel 
again from the toolbox. When the selection box appears, left-click on Dup to 
double the size of the element, either from left to right or from top to bottom, 
depending on the arrows in the Dup box you selected. Left-click on Mir to 
generate either a left/right or up/down mirror image of the element, depending 
on the arrows in the Mir box. When the element is the way you want it, move 
the cursor away from it and left-click to set it in place. 

To delete an element from a stage, first left-click on it on the animation board. 
Then select Cel from the toolbox and Delete from the selection box that appears. 
Finally, left-click on OK in the warning box. The element is erased from your 
frame. 
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Palettes 

The Palettes option lets you change the colors in your palette, and create up to seven 
additional palettes. Each palette contains 16 colors. In the Design menu, left-click on 
Palettes. The palette editor appears. Film Director's palette editor is very similar to the 
palette editor in Art Director. 

EDIT PALETTE 298 156 
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~ Tip: Using the Film Director palette editor modifies the palette of picture A 
•• only. 

Paintbox The colors shown in the paintbox are the colors currently in your 
palette. The colors are numbered as they appear in the palette from top to 
bottom. Colors 0 through 3 are in the far left column of the palette; colors 4 
through 7 are in the center left column; colors 8 through 11 are in the center 
right column; and colors 12 through 15 are in the far right column. The arrow 
marks the color currently showing in the color mixer. 

Color Mixer Use the color mixer to modify the colors in your palette. You can 
change one color at a time in the color mixer. The color currently in the mixer is 
shown with its RGB value. 

To change a color in the mixer, move the cursor onto an empty square in the 
RGB grid and left-click. The square will be highlighted and the color in the 
color bar will change, reflecting the new RGB value you just set. The same color 
in the paintbox also changes to the new color. When you return to the animation 
board, the new color appears in the palette in place of the original color. 

~ Tip: Do not set colors 0 and 15 to the same RGB value, or you will not be able 
•• to read the palette editor. If that happens, press Help to make your screen 

readable. 
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Palette Selector You can use up to eight palettes per canvas. In the palette 
selector, the palettes are labeled A through H. Left-click on a palette letter to 
select it. The letter of the palette currently selected has a box around it, and the 
colors of that palette appear in the paintbox. 

Copy This selection copies colors. The purpose of Copy is to move colors 
around within a palette, or from palette to palette. 

To copy a color within the same palette, first left-click on the color you want to 
copy in the paintbox. Then left-click on Copy. Finally, left-click on the color in 
the paintbox you want to copy over. The first color selected in the paintbox is 
copied over the second color. In the palette on your animation board, the first 
color selected will appear in its original position and in the position of the 
second color selected. 

To copy a palette, select a palette letter in the palette selector at the top of the 
palette editor. Then left-click on Copy. Finally, select a second palette letter in 
the palette selector. The colors in the first palette selected will be copied to the 
second palette selected. 

ii Tip: To deselect Copy, left-click on it again. 

Swap This selection exchanges colors within a palette or from palette to palette. 

To exchange colors in the same palette, select one color from the paintbox. Then 
left-click on Swap. Move the cursor back to the paintbox and select a second 
color to exchange with the first color. The two colors will trade places in the 
paintbox. 

To exchange the colors of two palettes, first select a palette letter in the palette 
selector. Then left-click on Swap. Finally, select a second palette letter. The 
colors of the two palettes will be swapped. 

ii Tip: To deselect swap, left-click on it again. 

Invert When you left-click on this selection, it inverts all colors on the palette. 
Inverting a color changes it to its complementary color--one that has the 
opposite RGB value. 

View Frame Lets you look at your current frame in color or monochrome. To 
view it in color, move the cursor to the upper right quadrant of the View square 
and hold down the left mouse button. To view it in shades of gray, move the 
cursor to the upper left quadrant and hold down the mouse button. Release the 
mouse button to return to the palette editor. 

View Picture Lets you look at your current picture in color or monochrome. To 
view it in color, move the cursor to the lower right quadrant of the View square 
and hold down the left mouse button. To view it in shades of gray, move the 
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cursor to the lower left quadrant and hold down the mouse button. Release the 
mouse button to return to the palette editor. 

Undo Left-click on Undo (or press the Undo key) to cancel the last action you 
took in the palette editor. 

After making your selections, left-click on OK to return to the animation board. 

Editor 

Selecting Editor puts you in Edit mode, with Edit as the third menu selection from the 
left. For complete information, see Edit Menu Options earlier in this manual. 

Options Menu Options 
The Options menu includes options for controlling the on-screen components, erasing 
frames, scripts, and pictures, and previewing an animated film. 

Select Cursor 

The Select Cursor option lets you select your cursor shape and speed. It also lets you 
restrict your cursor to the visible animation board or free it to move off the visible board 
area. 
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Left-click on Select Cursor to see its selection box: 

Choice Select the cursor shape you prefer. When you left-click on OK, that 
shape will appear on screen as the cursor. 

Speed Your selection--Slow, Normal, or Fast--determines how fast the cursor 
responds to your mouse movements. 

Range Select Restr to keep your cursor within the visible canvas. Selecting 
Free lets you move your cursor off screen--for example, when you want to move 
eels partially off the screen. 

ii Tip: If you lose the cursor, press F8 to return it to the center of the screen. 

' Make your selections, then left-click on OK to return to the animation board. 

Display Tools 

The Display Tools option lets you toggle certain screen displays on and off. Left-click on 
the option to see its selection box. 
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Message Selecting On displays the message line at the top left of the animation 
board. Selecting Off hides it. 

Coord Selecting On displays your cursor coordinates at the top right of the 
animation board. Selecting Off hides them. 

V Scale Selecting On displays a vertical scale at the left side of the animation 
board. The longer marks on the scale are spaced five pixels apart. Selecting Off 
hides the scale. 

H Scale Selecting On displays a horizontal scale at the bottom of the animation 
board. The longer marks on the scale are spaced five pixels apart. Selecting Off 
hides the scale. 

Make your selections and left-click on OK or press Return. 

Hide Display 

When you select Hide Display, all displays are hidden. To show the items that are "on" in 
the Display Tools selection box, display the Options menu and select Show Display. 

Hide Toolbox 

Select the Hide Toolbox option to remove the toolbox from the screen. To show the 
toolbox again, display the Options menu and select Show Toolbox. 
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Erase Frames 

This option is available when Edit is the third menu bar selection from the left. Select 
Erase Frames to erase the frames currently in memory, but leave intact all film elements 
(patterns, polygons, groups, actors, and stages). 

Using Erase Frames makes it possible for you to create a new film with those previously 
defined elements, as well as palettes and pictures. 

~ Tip: Once a series of frames is erased, it cannot be recalled unless it has been 
•• previously saved to disk as a .FLM file. 

Erase Script 

This option is available when Design is the third menu bar selection from the left. Select 
Erase Script to erase all patterns, polygons, groups, actors, and stages in memory, but 
leave intact the palettes and pictures. 

Using Erase Script makes it possible for you to begin defining new film elements with 
existing pictures and palettes. 

~ Tip: Once a script is erased, it cannot be recalled unless it has been previously 
•• saved to disk as an .SCR file or as part of a .FLM file. 

Erase Picture 

The Erase Picture option is available when Design is the third menu bar selection from 
the left. It lets you erase a picture from memory. 

When you select Erase Picture, its selection box appears listing the pictures in memory. 
Left-click on the picture you want to erase, then left-click on OK or press Return to . 
delete the picture. If you've cut a pattern out of the picture, it becomes a blank pattern iri 
memory. 

~ Tip: Once a picture is erased, it cannot be recalled unless it has been previously 
•• saved to disk as an .ART file or as part of a .FLM file. 

Show Film 

Select the Show Film option to view the animated film currently in memory. When you 
left-click on the option, its selection box appears. 

Direction Select Back or Forward to see your film in the reverse or forward 
direction. 
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Speed Select Slower or Faster to change the speed at which your film is shown. 
The number to the left of the selections changes. Speed 1 is the slowest; speed 
25 is the fastest. 

After making your selections, left-click on OK or press Return. The film will begin to 
play. 

During a show, right-click to stop a film at the last frame displayed. The Frame toolbox 
appears, and you can edit the frame. In this way you can use Show Film to find an 
incorrect frame and edit the problem. Left-click to resume showing the film. 

Using FILMSHOW.PRG 
FILMSHOW.PRG lets you show your animated films. From the GEM Desktop, copy the 
programs FILMSHOW.PRG, S.RSC, and S.INT to any disk containing a .FLM file. 
When you want to show your film, insert the disk into a drive and run FILMSHOW.PRG 
from the desktop. 

The program first searches for the file DEMO.FLM and runs that film. If DEMO.FLM is 
not on disk, the program displays a menu bar with two items: Desk and File. Display the 
File menu and select Load Film. An item selector appears from which you can select the 
film you want to show. When you left-click on OK, FILMSHOW. PRG shows the 
selected film. 

During the film, press the Left Arrow to watch your film in reverse. Press the Right 
Arrow to return to forward showing. Press the Down Arrow to slow down the film; 
press the Up Arrow to speed it up. Press Spacebar to pause the film; press it again to 
advance one frame. Press any key to resume the show. When the film is over, press Fl to 
restart it. Press Help or Control B to see the help screen. 

Display the File menu and select Show Film to see a selection box offering direction and 
speed options. Use this selection box in the same way you use the Show Film selection 
box while working in Film Director. 

Press Esc or select Quit from the File menu to exit the program and return to the GEM 
Desktop. 

Using MUSICSEL.PRG 
Film Director can load one music (.MUS) file at a time containing up to nine sounds that 
you can add to your animated films. The Film Director disks contain three music files, 
for a total of 27 sounds for you to choose from. The music selector program 
MUSICSEL.PRG lets you assemble your own music files by choosing sounds from the 
three existing files. 
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To create a custom music file, follow these steps: 

1. Insert the disk containing the program MUSICSEL.PRG and the music files into a 
drive. Then run MUSICSEL.PRG from the GEM Desktop. The program loads and 
displays a menu bar with two options: Desk and File. 

2. Display the File menu and select the Load Music option. An item selector appears 
listing the music files. 

3. Select the file you want. This will be your input file. When you left-click on OK, an 
edit box appears indicating the nine sounds in the file with the numbers 1 through 9. 

4. To preview a sound, left-click on a number, then left-click on Play. (To stop a sound 
before it finishes, left-click on Play again.) 

5. To add a sound from the input file to your output (custom) file, move the cursor to the 
number of the sound you want. Hold down the left mouse button and drag the sound to 
a location (from 1 through 9) in the output file. Release the mouse button. If the sound 
is where you want it, left-click on OK in the dialog box that appears. 

~ Tip: You can preview sounds in the output file by selecting a sound number 
•• and left-clicking on Play. 

6. To cancel your selections, select Cancel in the edit box. Doing this cancels all changes 
you made since entering the edit box. Then display the File menu and select Edit 
Music to return to the edit box with the same input file loaded. 

7. When you finish adding sounds from the input file to the output file, select OK. 

8. To copy sounds from a second input file to your output file, display the File menu, 
select Load Music, and load another input file. Copy the sounds you want, then select 
OK. 

I 

9. To save your output file, select OK in the edit box. Then display the File menu and 
select Save Music. In the item selector that appears, type a filename for your file. 
When you select OK, the file is saved with the extension .MUS to the disk in your 
drive. 

Select Quit from the File menu to exit the program. The File menu also contains the 
Delete File and Format Disk options. Use them in the same way you use the Delete File 
and Format Disk options in Art Director. 

Taping Your Art and Films 
Once you've created artwork or animated films using Art & Film Director, you can 
record your work on video tape. 
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Cabling 
If your Atari ST has a composite video port (such as the Atari 520S1FM) follow these 
steps: 

1. Plug one end of an RCA phono cable (a cable with male RCA jacks on both ends) into 
the female RCA jack on your computer. 

2. Plug the cable's other end into the Video In jack on the VCR. If the female Video In 
jack is not an RCA jack, insert an adapter between the cable and the Video In jack. 
(For example, some VCRs require an RCA to BNC adapter.) 

If your Atari ST does not have a composite video port, follow these steps: 

1. Connect an RGB to composite converter to the monitor port on your computer. 

2. Plug one end of an RCA phono cable (a cable with male RCA jacks on both ends) into 
the female RCA jack on your converter. 

3. Plug the cable's other end into the Video In jack on the VCR. If the female Video In 
jack is not an RCA jack, insert an adapter between the cable and the Video In jack. 
(For example, some VCRs require an RCA to BNC adapter.) 

Recording 
To record your Art & Film Director work, follow these steps: 

1. Insert the tape you want to use for your recording into your VCR. 

2. Prepare your VCR for recording by starting to record and then immediately pausing 
the VCR. (See your VCR manual for instructions.) 

3. Load whatever you want to record intoArt Director, Film Director, Art Show, or Film 
Show. If you're recording an animated film, begin showing the film, then immediately 
pause it. 

4. Unpause the VCR (and the animation if recording a film). 

5. When you've finished recording, stop or pause the VCR. (If you're going to record 
other pictures or films, it's better to pause the VCR rather than stop it.) 

~ Tip: When recording from Art Director, tum your display off by right-clicking 
•• on Display in the toolbox and setting all items to Off. When recording from 
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FILM DIRECTOR 
KEYBOARD SHORTCUTS 
With Film Director, you can make selections from the keyboard instead of using your 
mouse. Press the following keys for the selection listed next to each key. 

ii Tip: Alt indicates the Alternate key. Ctrl indicates the Control key. 

General Use 
Help or Ctrl B 

Tab or Ctrl I 

Alt Esc 

Alt Space 

Return 

Arrow keys 

A It Arrow keys 

Fl 

F2 

F3 

F4 

FS 

F6 

AltF6 

F7 

F8 

F9 

Toggle help screen on/off. 

Toggle message on/off. 

Display menu bar. 

Stop animation during a film show. Press any key to continue. 

Generally the same as left-clicking on OK (except when 
another selection is highlighted by default). 

Move cursor one pixel in indicated direction. 

Move cursor eight pixels in indicated direction. 

Select Patterns option. 

Select Polygons option. 

Select Groups option. 

Select Actors option. 

Select Stages option. 

Select Frames option. 

Select Sequences option. 

Show a film from the beginning. 

Place cursor at screen center. 

Select palette editor. 
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Undo 

Patterns 

Toggle toolbox display on/off. 

Same as left-clicking on Undo tool. 

When the Patterns option is selected (Fl), the following keys select toolbox items. 

Alt * or Alt Shift 8 Pattern selection box 

Alt-

Alt + or Alt Shift = 

Alt ( or Alt Shift 9 

Alt) or Alt Shift 0 

Insert 

Delete 

AltA 

AltG 

Alt C 

AltD 

AltZ 

1 

B 

Polygons 

<Step 

Step> 

First pattern 

Last pattern 

Insert blank pattern 

Delete current pattern 

Send pattern to end of series 

Get pattern from end of series 

Cut pattern 

Toggle Draw on/off 

Display Zoom area box 

Select picture 

Cut block pa:ttern 

When the Polygons option is selected (F2), the following keys select toolbox items. 

Alt * or Alt Shift 8 Polygon selection box 

Alt- <Step 

Alt + or Alt Shift = 

Alt ( or Alt Shift 9 
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Alt ) or Alt Shift 0 Last polygon 

Insert Insert blank polygon 

Delete Delete current polygon 

Alt C Copy polygon as next item 

AltA Append polygon to end of series 

AUT Tween single polygons 

Alt S Stage> 

Alt ShiftS <Stage 

Selecting Angles 
When an angle is selected in a polygon, use the following keys: 

AUF 

Alt Shift F 

Spacebar 

Groups 

Select next angle 

Select previous angle 

Deselect angle 

Mi@tmh§D 

When the Groups option is selected (F3), the following keys select toolbox items. 

Alt *or Alt Shift 8 Group selection box ; 

Alt- <Step 

Alt + or Alt Shift = Step> 

Alt ( or Alt Shift 9 First group 

Alt ) or Alt Shift 0 Last group 

Insert Insert blank group 

Delete Delete current group 

AltC Copy group as next item 

AltA Append group to end of series 
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AltT Tween single group 

AltS Stage> 

Alt ShiftS <Stage 

Altl Insert eel 

Alt Shift I Delete eel 

Cels 
When the Cel tool is selected, you can use the following keys: 

AltM 

Alt Shift M 

AltN 

Alt Shift N 

AltP 

Alt Shift P 

AltQ 

Alt Shift Q 

Return 

Modify eel> 

<Modify eel 

Layer up 

Layer down 

Pattern> 

<Pattern 

Polygon> 

<Polygon 

Same as holding down the left mouse button. Press Alt 
Return to release. 

Use the following keys to select eels on screen in the order they were saved in memory: 

AltF Select next eel 

Alt Shift F Select previous eel 

Spacebar Deselect eel 
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Actors 
When the Actors option is selected (F4), the following keys select toolbox items. 

Alt *or Alt Shift 8 Actor selection box 

Alt- < Step 

Alt + or Alt Shift = Step> 

Alt ( or Alt Shift 9 First actor 

Alt ) or Alt Shift 0 Last actor 

Insert Insert blank actor 

Delete Delete current actor 

Alt C Copy actor as next item 

AltA Append actor to end of series 

AltT Tween single phase 

AltS Stage> 

Alt ShiftS <Stage 

Alti Insert blank phase 

Alt Shift I Delete phase 

. ~ 

Phases 
When the Phase tool is selected, you can use the following keys: 

AltM Modify eel> 

Alt Shift M <Modify eel 

AltN Order> 

Alt Shift N <Order 

AltP Pattern> 

Alt Shift P <Pattern 
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AltQ 

Alt Shift Q 

AltG 

Alt Shift G 

Polygon> 

<Polygon 

Group> 

<Group 

Use the following keys to select phases on screen in the order they were saved in 
memory: 

AltF Select next phase 

Alt Shift F Select previous phase 

Spacebar Deselect phase 

Stages 
When the Stages option is selected (F5), the following keys select toolbox items: 

Alt * or Alt Shift 8 Stage selection box 

Alt- < Step 

Alt + or Alt Shift = Step> 

Alt ( or Alt Shift 9 First stage 

Alt ) or Alt Shift 0 Last stage 

Insert Insert blank stage 

Delete Delete current stage 

AltC Copy stage as next item 

AltA Append stage to end of series 

AltT Tween single stage 

Alt Shift T Text 

AltS Set background color > 

Alt ShiftS < Set background color 
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Altl Insert blank eel 

Alt Shift I Delete eel 

Cels 
When the Cel tool is selected, you can use the following keys: 

AltM 

Alt Shift M 

AltN 

Alt Shift N 

AltP 

Alt Shift P 

AltQ 

Alt Shift Q 

AltG 

Alt Shift G 

Return 

Modify eel> 

<Modify eel 

Layer up 

Layer down 

Pattern> 

<Pattern 

Polygon> 

<Polygon 

Group> 

<Group 

Same as holding down the left mouse button. Press Alt 
Return to release. 

Use the following keys to select eels on screen in the order they were saved in lllemory: 

AltF Select next eel 

Alt Shift F Select previous eel 

Spacebar Deselect eel 
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Text 
When Text is selected, you can use the following keys: 

Delete Delete all text 

Backspace Delete last character 

Esc Exit text mode 

Frames and Sequences 
When the Frames option (F6) or the Sequences (Ait F6) is selected, the following keys 
select toolbox items. 

~ Tip: Film Director accepts keyboard controls for frame manipulation while 
•• Sequences is selected, and vice versa. 

Alt * or Alt Shift 8 Frame selection box 

Alt- <Step 

Alt + or Alt Shift = Step> 

Alt ( or Alt Shift 9 First frame 

Alt ) or Alt Shift 0 Last frame 

Insert Insert blank frame 

Delete Delete frame 

Control D Delete sequence 

Alt C Copy frame as next item 

Alt Shift C Copy sequence as next item 

AltA Append frame to end of series 

Alt Shift A Append sequence to end of series 

AltT Tween single frame or path 

Alt Shift T Interpolate 

AltO Overlay 
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AltR Peel 

AltU Trace on 

Alt Shift U Trace off 

Alt S Stage> 

Alt ShiftS <Stage 

AltB Select stage in frame/sequence 

AltY Select palette in frame/sequence 

v Toggle View on/off 

w Increase speed by 1 

ShiftW Decrease speed by 1 

1 Set mark 1 

2 Set mark 2 

Alt 1 Go to mark 1 

Alt2 Go to mark 2 

c Select palette to the right 

Shift C Select palette to the left 

z Select music to the right 

Shift Z Select music to the left 

Alt I Insert eel 

Alt Shift I Delete eel 

Cels 
When the Cel tool is selected, you can use the following keys: 

AltM 

Alt Shift M 

Modify eel> 

<Modify eel 

*iimtmn;n 
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AltN 

Alt Shift N 

AltP 

Alt Shift P 

AltQ 

Alt Shift Q 

AltG 

Alt Shift G 

AltJ 

Alt Shift J 

Return 

Layer up 

Layer down 

Pattern> 

<Pattern 

Polygon> 

<Polygon 

Group> 

<Group 

Actor> 

< Actor 

Same as holding down the left mouse button. Press Alt 
Return to release. 

Use the following keys to select eels on screen in the order they were saved in memory: 

AltF Select next eel 

Alt Shift F Select previous eel 

Spacebar Deselect eel 

Show Film 
When the Show Film option is selected(F7), you can use the following keys: 

w Increase speed by 1 

ShiftW Decrease speed by 1 

F Show film forward 

B Show film in reverse 

Palettes 
When the Palettes option is selected (F9), press Alt I to invert colors. 
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